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1. Introducción 

 
El uso de la información geográfica en la toma de decisiones suele pasar desapercibido, pero 

en realidad se encuentra presente en muchas de nuestras actividades cotidianas. Al 

seleccionar inconscientemente la ruta para ir al trabajo, la ruta de vacaciones, ir a una 

reunión de amigos, dirigirse a una tienda usando un teléfono inteligente, se están tomado 

decisiones que implican el análisis de la información geográfica sin ser conscientes de ello. 

Cuando este tipo de análisis o de toma de decisiones se lleva a cabo empleando 

computadoras se suele hacer por medio de lo que se conoce como Sistemas de Información 

Geográfica (SIG). 

 
Según López Trigal (2015) un SIG es un conjunto de herramientas compuestos por hardware, 

software, datos y usuarios, que permite capturar, almacenar, administrar y analizar 

información digital, así como realizar gráficos y mapas, y representar datos alfanuméricos. 

De acuerdo a Burrough (1994) un SIG también puede verse como un modelo informatizado 

de la realidad geográfica para satisfacer unas necesidades de información concretas, esto es, 

crear, compartir y aplicar información útil basada en datos y en mapas. 

 
Durante décadas los SIG se han aplicado a problemas de gestión territorial y de recursos 

naturales, a cuestiones relacionadas con el medioambiente, la logística militar o en contextos 

directamente vinculados con las ciencias de la Tierra, como la geografía, la geología, etc. 

Además, recientemente se ha empezado a considerar el uso potencial de los SIG para otros 

campos y disciplinas relativamente inéditos y en particular en la investigación en Ciencias 

Humanas y Sociales (Del Bosque González et al. 2012). 

 
ArcGIS Desktop (En adelante ArcGIS) es el principal componente de la suite de aplicaciones 

ArcGIS de ESRI, y el software que contiene las funcionalidades clásicas del SIG de escritorio. 

ArcGIS es un conjunto de herramientas que permiten la visualización y manejo de 

información geográfica, y que cuenta con una arquitectura extensible mediante la que 

pueden añadírsele nuevas funcionalidades (Olaya, 2011) . Estas son las conocidas 

extensiones, entre las cuales se pueden destacar Spatial Analyst (análisis ráster), 3D Analyst 

(análisis 3D y de relieve) o Geostatistical Analyst (geoestadística). 

 
El propósito de este documento técnico es introducir conceptos básicos de los SIG a través 

del desarrollo de casos prácticos que involucran todo el proceso que implica la elaboración 

de un mapa. Literalmente existen cientos de herramientas en ArcGIS, pero no es posible 
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trabajar con todas ellas, no obstante, si es posible familiarizarse con el funcionamiento del 

programa. Este documento está diseñado para que a medida que se avance se puedan 

adquirir habilidades o mejorar las que ya tenemos de cara a la creación de mapas, búsqueda 

de información geográfica, y finalmente la publicación de un mapa bien editado. 

 
Además, se intenta compartir este documento por todos los medios posibles, por lo cual se 

autoriza copiar, remezclar, transformar, o redistribuir parcial o totalmente el material en 

cualquier medio o formato sin fines comerciales, pero siempre citando la fuente 

correspondiente de esta obra. 

 
Sin más novedades, damos iniciamos con el presente documento esperando sea de gran 

utilidad para usted. 

 
2. Términos geográficos 

 
La información geográfica en formatos digitales requiere una homologación de criterios e 

incorporación de parámetros mínimos que garanticen su calidad y que además permitan la 

interoperabilidad entre los usuarios para optimizar su utilización e intercambio, y lograr un 

reúso y democratización de la información (SENPLADES, 2013). 

 
A continuación, se detalla un glosario de los términos geográficos más relevantes que serán 

utilizados en el presente documento. Algunos términos provienen de la serie técnica 

Estándares de Información Geográfica publicado por SENPLADES (2013) en su sección 

Terminología para Información Geográfica, los cuales se basan en la Norma ISO/TS 

19104:2008 Geographic information - Terminology e ISO/TC 211 Multi-Lingual Glossary of 

Terms. Tenga en cuenta que los términos seguidos de las letras numeradas “A” o “B” hacen 

referencia a los Anexos de esta serie técnica. 

 
 Banda. – Cada una de las partes en las que se divide el espectro electromagnético a 

efectos de captar la radiación por los sensores. Los datos de radiación (valores 

numéricos) captados para cada banda definida se suelen organizar como archivos ráster 

(Moreno Jiménez, 2008). 

 Capa. - Unidad básica de la información geográfica que puede ser solicitada en forma de 

mapa desde un servidor [ISO 19128:2005]. Conceptualmente, una capa es una porción 

o estrato del espacio geográfico en un área en particular. Podría considerarse 

equivalente a un elemento de la leyenda del mapa (SENPLADES, 2013). 
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 Coordenada. - Valor medido sobre la superficie terrestre que sirve para determinar 

sobre ella la posición de cualquier punto y, en consecuencia, la que tiene respecto a 

cualquier otro lugar. Para determinar esos valores se utilizan líneas imaginarias, 

perpendiculares entre sí, denominadas paralelos y meridianos, cuya intersección define 

la posición del punto en el sistema de coordenadas (López Trigal, 2015). 

 Datum. - Parámetro o conjunto de parámetros que definen la posición (A.282) del 

origen, la escala y la orientación de un sistema de coordenadas [ISO 19111:2007]. 

 Datum vertical. - Datum que describe la relación de la altura relacionada con la gravedad 

o profundidad con la Tierra. NOTA: En la mayoría de los casos, al datum vertical se lo 

relaciona con el nivel medio del mar. Las alturas geodésicas se tratan en relación a un 

sistema de coordenadas elipsoidales tridimensional que hacen referencia a un datum 

geodésico [ISO 19111:2007]. 

 Elipsoide. - Superficie formada por la rotación de una elipse alrededor de un eje 

principal. NOTA: En esta norma internacional, los elipsoides son siempre oblongos, lo 

que significa que el eje de rotación es siempre el eje menor [ISO 19111:2007]. 

 Escala. – Relación que existe entre las magnitudes de los elementos representados en 

el mapa y las que estos mismos tienen en la realidad. Define la reducción a la que 

debemos someter a la superficie terrestre para poder representarla en un documento, 

en un mapa, cuyo tamaño es mucho menor. La representación de la escala en un mapa 

puede ser gráfica o numérica (López Trigal, 2015). 

 Geoposicionamiento. - Recuperación de la posición geográfica de un objeto [ISO/TS 

19130:2010]. 

 Georeferenciación. – Operación de obtener y asignar coordenadas geográficas a una 

información (normalmente una capa) que carece de ella. Suele aplicarse para situar 

imágenes de la Tierra o eventos asociados a direcciones postales (Moreno Jiménez, 

2008). 

 Imagen. - Cobertura tipo ráster cuyos valores de atributo son una representación 

numérica de un parámetro físico [ISO 19115-2:2009]. 

 Latitud. - Normalmente representada por el símbolo φ, es el ángulo formado, desde el 

centro de la Tierra sobre el plano de meridiano, por la normal al elipsoide en el punto 

considerado y el plano del ecuador. Todos los puntos de la superficie de la Tierra con 

igual latitud definen las líneas de paralelos. La medida se expresa en notación 

sexagesimal partiendo del Ecuador, positiva hacia el norte (0° a 90°) y negativa en el sur 

(0° a -90°) (Del Bosque González et al. 2012). 
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 Leyenda. - Aplicación de una clasificación (A.52) en un área específica usando una escala 

de mapeo definida y un conjunto específico de datos [ISO 19144-1:2009]. 

 Longitud. - Normalmente representada por el símbolo griego λ, es el ángulo diedro, 

formado desde el centro de la Tierra sobre el plano del ecuador, entre el meridiano que 

contiene el punto y el meridiano tomado como origen. El plano del ecuador es el que 

pasa por el centro de la Tierra y es perpendicular al eje de rotación. Los meridianos son 

las líneas formadas por todos los puntos de igual longitud, y representan la intersección 

de la superficie de la Tierra con planos perpendiculares al plano del ecuador y que 

contienen el eje de rotación (Del Bosque González et al. 2012). 

 Modelo digital del terreno y modelo digital de elevaciones. - Un modelo digital del 

terreno es una representación espacial de una variable cuantitativa y continua, como 

puede ser la temperatura, la cota o la presión atmosférica. En particular, cuando la 

variable a representar es la cota o altura del terreno se denomina Modelo Digital de 

Elevaciones o MDE. Por tanto, un modelo digital de elevaciones es una estructura 

numérica de datos que representa la distribución espacial de la altitud de la superficie 

del terreno (Mancebo at al. 2008). 

 Pendiente. - Relación de cambio de elevación con respecto a la longitud de la curva [ISO 

19133:2005]. 

 Proyección cartográfica. - Operación geométrica que permite representar la superficie 

curva de la tierra (tridimensional) en una superficie plana (bidimensional). 

Procedimiento que se utiliza para transformar las coordenadas angulares con las que se 

determina la localización de los objetos geográficos sobre el globo terrestre en 

coordenadas planas que permiten la representación cartográfica en una superficie de 

dos dimensiones (López Trigal, 2015). 

 Teledetección o Percepción Remota. - En un sentido amplio se puede definir como la 

adquisición de información sobre un objeto a distancia, esto es, sin que exista contacto 

material entre el objeto o sistema observado y el observador (Sobrino, 2000). 

 
3. Modelos de datos 

 
Podría parecer obvio, pero antes de trabajar con datos SIG, los mismos deben estar en 

formato digital. Casi todos los elementos que se encuentran sobre la superficie terrestre 

pueden ser codificados para que una computadora los pueda comprender, y en función del 

tipo de información se puede usar un modelo de datos u otro. Lo que no es tan obvio, es la 

forma de representar el mundo real a un medio digital (ESRI, 2010). 
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A pesar de la heterogeneidad de la información geográfica, existen dos aproximaciones 

básicas para simplificar y modelizar el espacio, de modo que éste pueda ser almacenado y 

manipulado en un sistema informático, dando lugar, por tanto, a dos modelos de datos: el 

modelo vectorial, habitualmente utilizado para tratar fenómenos geográficos discretos (vías 

de comunicación, tejidos urbanos, coberturas vegetales, etc.), y el modelo ráster usado 

generalmente para representar fenómenos continuos. Ambos sistemas son 

complementarios y conviven dentro de los SIG, aunque cada uno de ellos resulte más o 

menos apropiado para el estudio de un tipo de información específica (Del Bosque González 

at al. 2012). 

 
3.1. Modelo vectorial 

 
El modelo de datos vectorial se basa en el supuesto de que la superficie de la Tierra se 

compone de objetos discretos tales como árboles, ríos, lagunas, etc. (ESRI, 2010). En este 

modelo, no existen unidades fundamentales que dividen la zona recogida, sino que se recoge 

la variabilidad y características de esta mediante entidades geométricas. Para cada entidad 

geométrica las características son constantes. La forma de estas entidades se codifica de 

modo explícito, porque modeliza el espacio geográfico a través de una serie de primitivas 

geométricas que contienen los elementos más destacados de dicho espacio. Estas primitivas 

son de tres tipos: puntos, líneas y polígonos (Olaya, 2014). 

 
3.2. Modelo ráster 

 
La estructura de un ráster se basa en una matriz de celdas representadas en filas y columnas, 

cada celda puede almacenar información de una variable (precipitación, temperatura, 

humedad relativa, radiación solar, longitudes de onda del espectro electromagnético, etc.). 

 
El modelo ráster no recoge de forma explícita las coordenadas de cada una de las celdas, sino 

los valores de éstas. No resulta necesario acompañar a dichos valores de un emplazamiento 

espacial concreto, pues hacen referencia a un elemento particular de la malla, la cual 

representa una estructura fija y regular. Pero es necesario ubicar dicha malla en el espacio 

para después poder calcular las coordenadas de cada celda (Olaya, 2014). 

 
4. Ventana principal de ArcMap 

 
ArcGIS contiene un conjunto de aplicaciones para resolver problemas geográficos del mundo 

real a través de una secuencia de operaciones espaciales. ArcMap es la aplicación central que 
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Barra de menús 

Barras de herramientas 

Vista de datos 

Paneles 
Tabla de contenidos 

 
Botones para intercambiar entre 

Data View y Layout View 

permite ejecutar las tareas habituales y de análisis avanzado, así como mostrar los resultados 

por medio de atractivos mapas impresos o digitales. 

 
La estructura de la ventana principal de ArcMap (Figura 1) proporciona una Barra de menús, 

y debajo de la misma se encuentran las Barras de herramientas que pueden personalizarse 

desde el menú “Customize”. En la parte izquierda se localiza la Tabla de contenidos, lugar 

donde se encuentran todas las capas participantes. A la derecha y en sentido vertical se 

localizan los Paneles Results, ArcToolbox, Catalog, Search, etc., que se pueden activar 

independientemente. Para explorar la información geográfica existe la Vista de datos (Data 

View), y para diseñar el mapa antes de su publicación la vista de composición del mapa 

(Layout View). 

 

Figura 1. Vista general de la aplicación ArcMap 
 

La barra de herramientas Tools contiene las funciones usadas con mayor frecuencia en 

ArcMap. Las principales funciones de cada herramienta se describen en la Figura 2. 

 

 
Figura 2. Barra de herramientas Tools 
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- Las herramientas Zoom In/Zoom Out permiten acercarse o alejarse dentro de la vista 

de trabajo. Se puede dibujar un recuadro sobre el mapa para ver en mayor o menor 

detalle un área específica. 

- La herramienta Pan se utiliza para mover el mapa libremente hacia arriba, abajo, 

izquierda o derecha sin cambiar la extensión y sin sufrir un cambio en la escala de 

trabajo. Esta acción se denomina paneo. 

- Full Extent permite ver la extensión total de todas las capas participantes del mapa 

activo. 

- Las herramientas Fixed Zoom In/Fixed Zoom Out tienen la capacidad de impedir 

acercarse o alejarse demasiado y perder la vista del mapa, porque con cada clic, se 

acerca o aleja en una cantidad fija. 

- Previous Extent/Next Extent se usan para volver a una vista anterior de 

acercamiento o alejamiento. Se trata de un botón para "deshacer" la pantalla de 

navegación, muy útil cuando por error se ha perdido la vista del mapa. 

- Select Features/Clear Selected Features. La primera herramienta permite 

seleccionar a través de un rectángulo, polígono, lazo, círculo o línea las entidades. 

Una vez seleccionado se resaltan en azul. La segunda herramienta (Clear Selected 

Features) elimina la selección. 

- Select Elements permite seleccionar, mover o cambiar de tamaño gráficos o texto 

que se encuentren en el mapa. También se encuentra disponible en la barra de 

herramientas Draw. 

- La herramienta Identify por medio de un clic identifica las características geográficas 

de un elemento. 

- Measure mide la distancia y/o área de un sector dentro del espacio de trabajo. Es 

posible que si al inicio del trabajo con ArcMap cargamos una capa sin sistema de 

referencia espacial esta herramienta aparece inactiva. El motivo es que el programa 

desconoce las unidades de la capa. Lo que hay que hacer es indicárselas. Suponiendo 

que el sistema de referencia espacial de la capa es WGS84 17S (más adelante se verá 

qué quiere decir esto), entonces las unidades del mapa son metros. Hay que pinchar 

dos veces en el Data Frame (en Layers), ir a la pestaña General, y en el apartado Units, 

pinchar en Map y en Display, e indicar Meters. 

- Find permite buscar una entidad, lugar o dirección. 

- Go To XY permite localizar un punto a través de una coordenada en formato XY. 
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5. Sistemas de coordenadas 

 
El ser humano siempre ha sentido la necesidad de representar la superficie terrestre y los 

elementos situados sobre ella, gracias a ello surgieron los mapas (IGN & UPM-LatinGEO, 

2013). Los sistemas de coordenadas son fundamentales en el trabajo con SIG, aunque a 

menudo se pasan por alto. Todas las ubicaciones se identifican utilizando un sistema de 

coordenadas, pero una misma ubicación puede tener diferentes coordenadas dependiendo 

del sistema de coordenadas que utilice el conjunto de datos (ESRI, 2011b). 

 
Para entender de mejor manera los sistemas de coordenadas es necesario comprender los 

siguientes términos: proyección, elipsoide, geoide y datum. 

 
La proyección intenta representar geométricamente la superficie de la Tierra, la cual es 

curva, sobre una superficie plana. Pero al realizar este proceso inevitablemente se producen 

deformaciones y cada proyección genera un tipo diferente de distorsión. Antes de elaborar 

un mapa una de las decisiones más importantes es saber qué proyección se va a usar, porque 

cada proyección funciona mejor en un lugar específico. Las proyecciones pueden distorsionar 

la forma, área, distancia y dirección en un mapa, atributos por los cuales pueden ser 

categorizadas en conformes: conservan los ángulos entre meridianos y paralelos, pero 

mantienen las formas; equivalentes: mantienen constantes las relaciones de superficie; y 

equidistantes: mantienen las relaciones de distancia (Del Bosque González et al. 2012). 

 
El elipsoide es la figura geométrica que mejor se adapta a la forma real de la Tierra, por lo 

tanto, es aquel que permite idealizarla con un mejor ajuste. Una vez que se dispone de una 

expresión teórica para la forma de la Tierra el siguiente paso es la determinación de los 

parámetros que la definen. En el caso de utilizar la esfera hay que calcular su radio. En el caso 

de asumir el elipsoide como una forma de referencia se deben determinar las medidas de los 

semiejes menor y mayor (Olaya, 2014). Además, un elipsoide (también denominado 

esferoide) es una forma de tres dimensiones creada a partir de una elipse de dos 

dimensiones. La elipse es un óvalo, con un eje mayor (el eje más largo) y un eje menor (el eje 

más corto). Si se hace girar la elipse, la forma de la figura girada es el esferoide (ESRI, 2015). 

 
El geoide se define como la superficie del campo de gravedad de la Tierra, el cuál es 

aproximadamente igual al nivel medio del mar. Es perpendicular a la dirección de la atracción 

gravitatoria dado que la masa de la Tierra no es uniforme en todos los puntos y la dirección 

de gravedad cambia. La forma del geoide es irregular (ESRI, 2015). 
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Figura 3. Relación entre el geoide, la superficie topográfica y el ajuste del elipsoide. Crédito de la imagen: Peter 

H. Dana, 1994. 
 
 

El datum especifica el esferoide que será usado para dar la forma al sistema de coordenadas. 

También orienta al esferoide a una serie de puntos terrestres de control, lo que garantiza la 

precisión de un punto de referencia para su región prevista o extensión espacial (ESRI, 

2011b). El datum se genera encima del esferoide seleccionado y puede incorporar 

variaciones locales en la elevación. Con el esferoide la rotación de la elipse crea una superficie 

totalmente suavizada de todo el mundo. Dado que así no se refleja adecuadamente la 

realidad, un datum local puede incorporar variaciones locales en la elevación (ESRI, 2015). 

Recuerde que la palabra datum en español es punto cero o punto de referencia (que vincula 

el elipsoide usado a la Tierra). 

 
Para entender de una forma sencilla, la proyección es el método utilizado para representar 

la forma circular de la Tierra en un plano, y el datum es el conjunto de parámetros que usa 

para hacerlo. 

 
La información geográfica puede mostrarse de acuerdo a un sistema de coordenadas 

geográficas o un sistema de coordenadas proyectadas. El sistema de coordenadas 

geográficas indica una ubicación usando la longitud y latitud basado en una esfera 

(esferoide). El sistema de coordenadas proyectadas XY se basa en un plano (Hillier, 2011). 

Los sistemas de referencia geodésicos más usados en Sudamérica son: WGS84, PSAD56, y 

SIRGAS. Además, algunos sistemas de coordenadas tienen ciertas ventajas, tales como la 

capacidad para medir rápidamente la distancia plana y superficies. 

 
6. Georreferenciación 

 
La georreferenciación es una técnica de posicionamiento espacial por medio de la cual a una 

imagen digital se le asigna un sistema de referencia basado en coordenadas conocidas. 
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Figura 4. Imagen aérea sin georreferenciación 
 
 

Cierta información ráster no está asociada a un sistema de referencia, tales como mapas, 

cartas topográficas escaneadas, imágenes aéreas, y un largo etc. Para vincular una imagen a 

un sistema de coordenadas conocido se debe realizar el proceso de georreferenciación, el 

cual se explica a continuación. 

 
En la georreferenciación de una imagen aérea, una vez ejecutada la aplicación ArcMap, para 

llamar la imagen se hace clic en el ícono Add Data de la barra Standard (Figura 5). 

 

Figura 5. Barra de herramientas Standard 
 
 

Se explora el directorio y se selecciona el archivo ráster que se pretende georreferenciar 

(para el presente ejemplo se puede capturar y/o guardar la imagen de la Figura 4 en formato 

tif, jpg, png), ignorar el mensaje de referencia espacial desconocida. En las cartas topográficas 

se pueden identificar generalmente varios puntos de control a través de las coordenadas que 

se muestran en los ejes X y Y. En este ejemplo se usan dos puntos conocidos P1 (UTMX: 

691194; UTMY: 9532767) y P2 (UTMX: 691895; UTMY: 9532347). 

 
Se activa la barra de herramientas Georeferencing (Figura 6), en caso de que no se encuentre 

se lo hace desde el menú Customize > Toolbars. 
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Figura 6. Barra de herramientas Georeferencing 
 
 

Hay que asegurarse que la imagen agregada (imagen_georreferenciar.jpg) se encuentre 

seleccionada dentro de la barra. En caso que no se pueda ver la imagen en la vista actual de 

pantalla hacer clic en Georeferencing > Fit To Display. 

 
Ahora hacer clic en el ícono Add Control Points; esta herramienta permite ajustar la imagen 

espacialmente por medio de puntos conocidos. El primer paso consiste en marcar un punto 

conocido sobre la imagen (P1). Al colocar el cursor se torna de color verde, luego dar clic 

derecho y seleccionar Input X and Y para ingresar las coordenadas XY (Figura 7). El proceso 

se repite para el segundo punto (P2) y para los otros puntos que se requieran añadir. 

 
Para concluir con la georreferenciación luego de haber conseguido un ajuste aceptable de 

los puntos de control, ir a Georeferencing > Update Georeferencing. Esto creará archivos 

auxiliares a la imagen actual que contienen las transformaciones efectuadas, si se selecciona 

Rectify se guardan los cambios en una nueva imagen ráster. 

 

Figura 7. Ingreso de coordenadas XY 
 
 

Si no se cuenta con las coordenadas de los puntos de control sobre el terreno, pero se tiene 

elementos de referencia como vías, edificaciones, árboles, etc., también es posible que estos 

elementos sean empleados para georreferenciar. Por ejemplo, la georreferenciación de una 

imagen en base a un shapefile de vías, se realiza identificando un punto común (intersección) 

en ambas capas (hacer Zoom To Layer con clic derecho sobre la capa de vías, luego llamar la 

imagen con Fit To Display desde la barra Georreferencing). Para crear un vínculo, primero 

hacer clic en la imagen para marcar el punto inicial (cruz verde en Figura 8a), un segundo clic 

se marca en el punto real del terreno (cruz gris en Figura 8a). Para los siguientes puntos se 

repite el proceso de forma similar a la descrita anteriormente. La línea azul que une a los 

puntos de control significa que se ha creado un vínculo asociado entre un punto que se ve en 
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a b 

la imagen con el mundo real (Figura 8b). El ajuste de las dos capas se realiza automáticamente 

después de cada asociación de puntos. 

 

Figura 8. Proceso de georreferenciación, (a) punto inicial de vinculación, (b) puntos vinculados 
 
 

El número de puntos de control no se refleja estrictamente en la calidad del resultado, lo 

importante es realizar una distribución adecuada. No se recomienda concentrar los puntos 

de control en un solo sector (Figura 9b), sino homogéneamente dentro de la imagen (Figura 

9a). A mayor número de puntos se pueden aplicar transformaciones más complicadas 

(polinomio, spline, ajuste o proyectiva) para determinar la ubicación adecuada de las 

coordenadas para cada celda de la imagen ráster. 

 

Figura 9. Distribución de puntos de control, (a) homogénea, y (b) local 
 

 

7. Generación de entidades vectoriales 

 
7.1. Creación de shapefiles 

 
Para la creación de nuevas entidades vectoriales como puntos, líneas o polígonos, se utiliza 

la aplicación ArcCatalog (abrir desde el menú inicio de Windows). En la parte izquierda de la 

ventana se encuentra un panel llamado Catalog Tree. Dentro de él se debe hacer clic derecho 

sobre Folder Connections (Figura 10) para seleccionar los directorios que servirán como 

 

17 

a b 

a
c
o

lit
a

.c
o

m
 



www.acolita.com/tienda 

 
 
 

ubicación de archivos de trabajo dentro de ArcGIS (se puede seleccionar toda una unidad de 

disco duro, para evitar crear excesivas conexiones). 

 

Figura 10. Conexión a un directorio en ArcCatalog 
 
 

Una vez que se ha realizado la conexión de los directorios se puede crear una nueva entidad 

haciendo clic derecho en la sección Contents > New > Shapefile… o dirigiéndose al menú File 

> New > Shapefile… 
 
 

Figura 11. Creación de nuevas entidades shapefile 
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Configurar los campos que se muestran en la Figura 11 de la siguiente manera: 
 

- Name: Asigna el nombre del nuevo shapefile, se recomienda no usar caracteres 

especiales ni espacios. 

- Feature Type: Selecciona el tipo de capa, ya sea punto, línea o polígono. 

- Spatial Reference: En esta sección se define el sistema de referencia utilizando el 

botón Edit. 

Para el presente caso se aplica: Projected Coordinate Systems > UTM > WGS 1984 > 

Southern Hemisphere > WGS 1984 UTM Zone 17S. Las casillas “Coordinates will 

contain M values. Used to store route data” y “Coordinates will contain Z values. Used 

to store 3D data” dejarlas, tal y como vienen por defecto, desactivadas. 

 
Práctica: Crear shapefiles tipo puntos, líneas y polígonos de la Tabla 1; usar el sistema de 

referencia WGS 1984 UTM Zone 17S. 

 
Tabla 1. Lista de shapefiles 

 

Shapefile Tipo 

edificaciones Punto 

puntos_hidrantes Punto 

sitios_seguros Punto 

red_vial Línea 

red_hidrica Línea 

cobertura_vegetal Polígono 

lago_laguna Polígono 

 
 

7.2. Edición de shapefiles 

 
Para crear nuevos elementos o editar los existentes dentro de un shapefile, se regresa a la 

aplicación ArcMap y se deben añadir los shapefiles generados como capas desde el ícono 

Add Data de la barra de herramientas Standard (Figura 2). 

 
Para iniciar la edición se debe activar la barra de herramientas Editor (Figura 12). Dirigirse a 

Editor > Start editing para activar la edición en el espacio de trabajo (shapefile). En el 

siguiente cuadro de dialogo que aparece se selecciona la capa o espacio de trabajo a editar. 

En caso de advertencias, se las omite y se da clic en continuar. Luego aparece el panel Create 

Features (izquierda) con una lista de las capas actuales clasificadas por su geometría (puntos, 

líneas y polígonos), y en Construction Tools se selecciona la característica que se desea 

editar. La idea central de la edición de un shapefiles es cartografiar los elementos presentes 
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en una imagen (para mantener un orden iniciar primero trabajar con los puntos, 

seguidamente con las líneas y finalmente con los polígonos). Después se pueden realizar 

todos los cambios requeridos en el shapefile elegido. Para finalizar la edición dirigirse a Editor 

> Stop editing y se guardan las modificaciones. Los cambios solo afectan a la entidad vectorial 

seleccionada. 

 

Figura 12. Barra de herramientas Editor 
 
 

7.3. Trabajando con puntos 

 
Para comenzar a digitalizar puntos se selecciona una capa de puntos (p.ej. edificaciones) en 

el panel Create Features. Es conveniente asegurarse de que en Construction Tools (parte 

baja) se encuentre marcada la herramienta Point. Después se ubica sobre el centro de una 

vivienda y hacer un clic para marcar un punto. El proceso se repite hasta digitalizar todas las 

viviendas (Figura 13). Para facilitar el trabajo con objetos pequeños se usan las herramientas 

de zoom y para imágenes grandes la herramienta de paneo, de esa forma se obtiene mayor 

versatilidad durante el proceso. A más de usar el ratón (mouse) es posible utilizar las flechas 

de desplazamiento del teclado, las cuales permiten mayor precisión en el movimiento. Se 

recomienda ir periódicamente a la barra de herramientas Editor > Save Edits para guardar 

los cambios. 

 

Figura 13. Modo edición de la aplicación ArcMap 
 
 

También se pueden crear nuevos puntos ingresando coordenadas XY. En este caso se 

selecciona una capa de puntos (p. ej. puntos_hidrantes) en el panel Create Features; no se 
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debe olvidar marcar “Point” en Construction Tools. Después ubicarse en cualquier parte del 

mapa, hacer clic derecho y selecciona Absolute X, Y… (Figura 14). Se abre una ventana en 

donde se puede ingresar los valores de XY (p. ej. X = 691491; Y = 9532534 para el primer 

punto, X: 691735; Y: 9532696 para el segundo punto). El ingreso se acepta pulsando la tecla 

“Enter”. 

 

Figura 14. Insertar manualmente puntos por medio de coordenadas 
 
 

Se pueden ingresar coordenadas en diferentes formatos como metros, grados decimales, 

MGRS, UTM, etc. Para cambiar el formato se abre la ventana Absolute X, Y como 

anteriormente se explicó y se hace clic en la parte derecha superior en un ícono despegable. 

Se abre una lista de opciones donde se puede seleccionar el formato. El formato UTM se 

ingresa como se representa en la Figura 15 (p.ej. sitios_seguros: 17M 691523 9532468, 17M 

691684 9532576, 17M 691889 9532681, 17M 691437 9532615). Presionando la tecla “Enter” 

se ingresa cada uno de los puntos requeridos. Finalmente se debe guardar la edición desde 

la barra Editor (Editor > Save Edits). 

 
 
 
 
 
 
 
 
 
 
 
 

Figura 15. Formato de coordenadas disponibles en Absolute X, Y 
 
 

Para corregir la ubicación espacial de un punto, primero se debe seleccionar la capa a 

modificar (shapefile) en el panel Create Features. Después se hace un clic en la barra Editor 
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en el símbolo (= Edit Tool). Para modificar la ubicación de un punto o eliminarlo, se 

selecciona el punto requerido con un clic (éste se torna de color celeste). Ahora es posible 

arrastrarlo hacia una nueva ubicación (ver Figura 16) o eliminarlo presionando “Supr” en el 

teclado. 

 

Figura 16. Herramienta Edit Tool 
 
 

7.4. Trabajando con líneas 

 
Para digitalizar líneas se selecciona la capa requerida en el panel Create Features (p.ej. 

red_vial). En la sección Construction Tools se debe hacer clic en Line como se muestra en la 

Figura 17. Para dibujar la línea se marca con un clic el punto inicial y luego se sigue punto a 

punto hasta completar una sección (p. ej. una vía). Para finalizar la línea se hace doble clic 

en el último vértice o se pulsa la tecla F2. Los nodos en verde indican la cantidad de puntos 

que se han marcado para construir la polilínea; el nodo rojo es el último punto marcado. El 

procedimiento se repite para todos los tramos del shapefile (p.ej. toda la red vial). 

 
Al momento de digitalizar líneas es importante mantener la conectividad entre sus 

elementos. Por ejemplo, en el caso de la red vial no se puede tener tramos que no se 

conecten entre sí, tampoco sectores donde las conexiones sobrepasen los bordes de una 

entidad existente. Para tener mayor exactitud en la edición y evitar errores, las herramientas 

de Snapping (Customize > Toolbars) permiten que el puntero se ajuste automáticamente a 

los bordes, vértices u otros elementos geométricos cercanos bajo una determinada 

tolerancia ajustable. 

 
Práctica: Para la capa red_hidrica, identificar el cauce del río en la Figura 4, seguidamente 

proceder con la digitalización de la misma forma como se realizó con la red vial. 
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Figura 17. Digitalización de líneas en ArcMap 
 
 

Si se desea modificar una polilínea, se debe seleccionar el ícono Edit Tool ) en la barra de 

herramientas Editor. Después hacer un clic sobre un segmento, lo cual hará que tome un 

color celeste. Ahora se puede eliminar la línea o mover la línea completa. Si se realiza un 

doble clic sobre el segmento requerido se muestran todos los vértices que conforman la 

polilínea. Así se puede mover libremente cada uno de los vértices hasta obtener la trayectoria 

deseada (Figura 18). 

 
 

 

Figura 18. Modificación de polilíneas 

Se recomienda evitar 

colocar demasiados 

vértices en una línea recta; 

es suficiente/ factible 

colocar solo vértices en los 

puntos extremos. En una 

curvatura se necesita una 

mayor cantidad de vértices 

para ajustarse bien a su forma. Si se desea eliminar un vértice se debe hacer clic derecho 

sobre él y luego seleccionar Delete Vertex. Para adicionar uno o más vértices hacer clic 

derecho sobre el segmento de la polilínea y seleccionar Insert Vertex. En algunos casos se 

requiere dividir en dos o más partes una polilínea. Para ello se debe seleccionar la polilínea y 

con Split Tool ( ), ubicada en la barra de herramientas Editor, se divide la línea con un clic 

en el punto requerido (que se resalta en rojo). 

 
Para eliminar una línea por completo, debe seleccionar la línea con la herramienta Edit Tool 

y pulsar la tecla “Supr”. Para seleccionar dos o más líneas se presiona la tecla “Mayúsculas”. 
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7.5. Trabajando con polígonos 

 
El proceso de digitalización de polígonos es similar al de polilíneas. En el panel Create 

Features se selecciona la capa (p.ej. cobertura_vegetal) y se elige Polygon en el Construction 

Tools. Para iniciar se marca con un clic el primer vértice y luego se continúa dibujando todo 

el perímetro del área. Para finalizar se hace doble clic o se pulsa la tecla “F2”. Se pueden 

definir varias categorías (p.ej. Figura 4: pastizal, cultivos y bosque). 

 

Figura 19. Edición de polígonos en ArcMap 
 
 

En el caso de los polígonos, cuando se comparte un lado, es necesario asegurarse que no 

existan superficies solapadas ni espacios vacíos en sus límites. 

 
 

 

Figura 20. Huecos y solapamiento en polígonos 

Los huecos o espacios vacíos por lo 

general no suelen apreciarse a simple 

vista, sino cuando se realiza un gran 

acercamiento a los límites de las 

parcelas. De la misma manera se 

pueden encontrar áreas compartidas 

por dos o más polígonos, lo que se 

denomina solapamiento (ver Figura 20). 

Por lo general estos errores topológicos 

se presentan cuando en la edición no se 

usaron métodos para mantener las reglas topológicas. En otras ocasiones puede ocurrir al 

compilar información de diversas fuentes o escalas diferentes. 
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En ArcMap existen varias herramientas que permiten mantener la integridad y calidad al 

editar información espacial. Dos herramientas fundamentales están ubicadas en la barra 

Editor (Cut Polygons Tool y Reshape Feature Tool) y otra en la sección Construction Tools 

(Auto Complete Polygons) que permiten digitalizar satisfactoriamente una capa poligonal, 

reduciendo significativamente la cantidad de errores que suelen generarse en esta actividad. 

 
Cuando se intenta dibujar una superficie con subdivisiones, es preferible crear primero el 

perímetro externo y posteriormente hacer la división interna. Por ejemplo, cuando se 

construye un mapa de usos del suelo, se recomienda dibujar toda el área de estudio y luego 

dividir sus categorías. Para llevar a cabo este proceso, se activa la herramienta Edit Tool ( 

) en la barra Editor y se selecciona el polígono requerido (se tornan sus bordes en celeste). 
 

Después se hace clic en Cut Polygons Tool ( ). Para cortar el polígono se marca el primer 

punto fuera del polígono y se sigue dibujando una línea de corte al interior del área. El último 

punto debe estar en el exterior del polígono (ver Figura 21). El corte se finaliza con un doble 

clic o pulsando “F2”. Se puede repetir el proceso las veces que sean necesarias hasta que 

todas las divisiones requeridas del área estén hechas. Cabe recalcar que esta herramienta 

sólo se activa cuando uno o varios polígonos están seleccionados. 

 

 

Figura 21. Cortar polígonos en ArcMap 
 
 

En la edición de polígonos también se requiere conocer cómo cambiar su forma, sobre todo 

cuando se necesita realizar ciertos reajustes geométricos. Para ello se debe seleccionar el 

polígono (con la herramienta Edit Tool) y luego hacer clic en el ícono Reshape Features Tool 

( ) ubicado en la barra de herramientas Editor. En la Figura 22 se da un ejemplo de cómo 

cambiar la forma del polígono. En los dos primeros polígonos a la izquierda se muestra como 

aumentar el área de un polígono (aquí: forma cuadrada). Lo importante es siempre iniciar y 

finalizar el dibujo de reajuste en el interior del polígono. En el lado derecho, los dos últimos 

polígonos muestran cómo reducir el área de un polígono (aquí: obtener una forma cuadrada). 

Para el reajuste se debe iniciar y finalizar el dibujo en el exterior del polígono. 
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Figura 22. Cambiar la forma a un polígono 
 
 

Si se requiere crear polígonos que se encuentren uno al lado del otro, no se debe digitalizar 

un borde dos veces, pero se debe mantener una estructura continua (sin solapamientos ni 

espacios vacíos). Para crear polígonos continuos dirigirse al panel Create Features, en la 

sección Construction Tools marcar la opción Auto Complete Polygons ( ). Para comenzar 

a dibujar los nuevos polígonos continuos no es necesario seleccionar las entidades 

participantes. El nuevo polígono se dibuja con al menos dos vértices que se conecten con sus 

vecinos (Figura 23). 

 

Figura 23. Autocompletar polígonos 
 
 

Adicionalmente, con cierta frecuencia se requiere fusionar dos o más polígonos dentro de un 

shapefile. Para ello se requiere seleccionar los polígonos participantes, presionando la tecla 

“Mayúsculas” durante la selección. Después se aplica la herramienta Merge desde la barra 

de herramientas Editor (Editor > Merge). 

 
Práctica: En las capas cobertura_vegetal y lago_laguna realizar la digitalización de los 

polígonos, haciendo uso de sus herramientas de edición. Cuando se haya culminado con 

todas las actividades de digitalización de puntos, líneas o polígonos, finalizar la edición con 

Stop Editing ubicado en la barra de herramientas Editor (Editor > Stop Editing). 

 
7.6. Definir proyección a una capa 

 
En determinadas ocasiones al momento de cargar nuevas capas en ArcMap se obtiene un 

mensaje de advertencia (The following data sources you added are missing spatial reference 

information. This data can be drawn in ArcMap, but cannot be projected). Esto se debe a que 
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las capas añadidas no cuentan con un sistema de coordenadas. Probablemente al momento 

de crear las capas se omitió definir el sistema de referencia espacial. 

 
No se recomienda definir un sistema de coordenadas cuando no se tiene la certeza de 

seleccionar el correcto. Para definir el sistema de coordenadas en una capa (vectorial o 

raster) dirigirse a la siguiente dirección: 

 
ArcToolbox > Data Management Tools > Projections and Transformations > Define Projection 

 

En la ventana emergente se debe configurar los parámetros que se describen a continuación: 
 

- Input Dataset or Feature Class .- Seleccionar la capa vectorial o ráster. 

- Coordinate System.- Seleccionar el sistema de coordenadas (Projected Coordinate 

Systems > UTM > WGS 1984 > Southern Hemisphere > WGS 1984 UTM Zone 17S). 

 
7.7. Proyectar una capa a otro sistema de referencia 

 
La herramienta Project permite proyectar los datos espaciales de un sistema de coordenadas 

a otro diferente. 

 
Práctica: Se requiere proyectar una capa con el sistema de coordenadas “WGS 1984 UTM 

Zone 17S” a “Provisional South American Datum UTM Zone 17S”. Se debe tomar en cuenta 

que ambos sistemas tienen diferente datum (WGS84 y PSAD56). Por lo tanto, se requiere 

aplicar las transformaciones correspondientes para cada localidad. En el archivo 

geographic_transformations.pdf localizado en la carpeta de instalación de ArcGIS 

“C:\Program  Files\ArcGIS\Desktop10.x\Documentation”  se  puede  encontrar  la  lista  de 

transformaciones (Figura 24). 

 
 
 
 
 
 
 
 
 
 
 

Figura 24. Fragmento del documento “Geographic and Vertical Transformation Tables” 
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Para ejecutar la reproyección abrir la herramienta Project (Figura 25) y configurarlo de la 

siguiente manera en: 

 
ArcToolbox > Data Management Tools > Projections and Transformations > Project 

 
 

Figura 25. Proyectar una capa a otro sistema de coordenadas 
 

- Input Dataset or Feature Class.- Selecciona la capa a ser proyectada. 

- Input Coordinate System.- Por defecto se muestra el sistema actual de coordenadas 

de la capa. 

- Output Dataset or Feature Class.- Selecciona el directorio o geodatabase donde se 

va a almacenar el archivo resultante. 

- Output Coordinate System.- Selecciona el nuevo sistema de coordenadas. En este 

caso ir a: Projected Coordinate Systems > UTM > South America > Provisional South 

American Datum UTM Zone 17S. 

- Geographic Transformation.- Selecciona la transformación de la lista del documento 

“Geographic and Vertical Transformation Tables”. En este caso 

“PSAD_1956_To_WGS_1984_14” porque la capa a ser proyectada se encuentra en 

Ecuador continental. También se podría seleccionar 

“PSAD_1956_To_WGS_1984_6”, pero tomar en cuenta que la precisión es menor, 

ver Figura 24. 
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En las versiones inferiores a ArcGIS 10.3 la herramienta Project suele estar ubicada en 

Projections and Transformations > Features. Para cambiar el sistema de coordenadas en un 

archivo ráster usar la herramienta Project Raster ubicada en Projections and Transformations 

> Raster. 
 

8. Administración de tablas 

 
Las tablas se usan para almacenar información descriptiva. En ArcGIS suelen estar vinculadas 

a una capa vectorial o participando de forma individual. La información alfanumérica que 

forma una tabla puede ser almacenada como número entero, número decimal, texto o fecha. 

Los formatos de tabla que se admiten son diversos: Geodatabases, bases de datos, INFO, 

dBASE, archivos de texto, Microsoft Excel, Access, SQL, etc. 

 
8.1. Trabajando con tablas 

 
Cada shapefile contiene una tabla asociada en formato DBF. Para ver la tabla de un archivo 

vectorial en ArcMap hacer clic derecho sobre una capa y seleccionar Open Attribute Table. 

 
Una tabla está estructurada en filas y columnas. Cada fila se puede considerar como un 

objeto que contiene valores en diferentes campos. Una columna se restringe a un solo tipo 

de datos y se considera como un campo. En una tabla se pueden añadir tantos campos como 

se requieran. 

 

Una vez abierta la tabla se puede crear un nuevo campo dirigiéndose a Table Options  

) y seleccionando Add Field (se debe tomar en cuenta que no esté activa ninguna edición, 

caso contrario dar clic en “Stop Editing”). Luego aparece un cuadro de diálogo donde se debe 

especificar el nuevo campo (ver Figura 26). Primero se puede dar un nombre al nuevo campo, 

teniendo en cuenta que no se pueden incluir espacios ni caracteres especiales y se limitan a 

una longitud de ocho caracteres en shapefiles y tablas dfb. Después se especifica el tipo del 

campo para lo cual existen varias opciones para aclarar qué datos están permitidos dentro 

de este campo (numéricos: short integer, long integer, float o double; text = texto; date = 

fecha). Finalmente se especifican las propiedades de este campo (“Field Properties”) donde 

se limita la precisión (números) o el espacio (texto) de los caracteres. 
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Figura 26. Añadir campos a una tabla 
 
 

Para elegir el tipo de un nuevo campo se debe considerar la información proporcionada por 

(Neer, 2005): 

 
 Short Integer, son números enteros entre -32768 y 32767. 

 Long Integer, son números enteros entre -2147483648 y 2147483647. 

 Float, son números fraccionarios entre -3.4E38 y 1.2E38. 

 Double, son números fraccionarios entre -2.2E308 y 1.8E308. 

 Text, es una cadena de texto limitada a una longitud de 255 caracteres. 

 Date, son datos almacenados en Coordenadas Universales de Tiempo (UTC, por sus 

siglas en inglés). 

 
Para ingresar información dentro de cada campo, es necesario estar en modo de edición 

(Editor > Start Editing). Después se abre la tabla de atributos (“Open Attribute Table”) y se 

pueden ingresar directamente valores a un registro dentro de un campo. 

 
Para añadir la misma información/calculo a una o varias filas, se hace clic derecho sobre el 

campo requerido (p.ej. Tipo) y selecciona la herramienta “Field Calculator”. Se abre un nuevo 

cuadro de diálogo donde por defecto se encuentra activado VB Script de la sección “Parser” 

(en caso de ser necesario cambiar a Python). En la sección “Fields” se encuentran todos los 

campos de la tabla actual, y en la sección “Type” muestra el tipo de datos (Figura 24). Para 

ingresar la información se debe escribir los números directamente, el texto entre comillas 

(“”, p.ej. seleccionar arbitrariamente una o varias edificaciones y llamarlas “Escuela”; se 
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puede repetir el proceso para “Iglesia”, “Hospital” o “Vivienda”) en la ventana de la parte 

inferior. 
 
 

Figura 27. Ingreso de información con Field Calculator 
 
 

Práctica: Añadir nuevos campos a los shapefiles y configurar su nombre, tipo y propiedades 

como se muestra en la Tabla 2. 

 
Tabla 2. Estructura para la creación de campos en las tablas 

 

Shapefile Nombre Tipo Propiedades 

edificaciones Tipo Text Length: 25 

puntos_hidrantes Nombre Text Length: 25 

sitios_seguros Nombre Text Length: 25 

red_vial Tipo 

Longitud 

Text 

Double 

Length: 25 

Precision: 0, Scale: 0 

red_hidrica Nombre 

Longitud 

Text 

Double 

Length: 25 

Precision: 0, Scale: 0 

cobertura_vegetal Tipo 

Area 

Porcentaje 

Text 

Double 

Double 

Length: 25 

Precision: 0, Scale: 0 

Precision: 0, Scale: 0 

lago_laguna Nombre 

Area 

Perimetro 

Text 

Double 

Double 

Length: 25 

Precision: 0, Scale: 0 

Precision: 0, Scale: 0 

Llenar los valores de las tablas en base a la siguiente información: 
 

- puntos_hidrantes, en el campo Nombre al primer punto llamarlo “Principal” y al 

segundo “Secundario”. 

- sitios_seguros, en el campo Nombre el primer y cuarto punto llamarlos “Sitios 

seguros” al segundo y tercer punto “Zona de encuentro”. 
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- red_vial, dentro del campo Tipo nombrar como “Vía principal” a las entidades que 

se extienden a lo largo de la coordenada X: 691723 Y: 9532552, “Vía Lastrada” para 

el segmento que se extiende en la coordenada X: 691394 Y: 9532401, “Sendero” para 

el segmento que se extiende en la coordenada X: 691570 Y: 9532693, y “Calle” a 

todos los segmentos restantes en la zona urbana. 

- red_hidrica, en el campo Nombre llamar como “Río Malacatos”. 

- cobertura_vegetal, en base a la Figura 4 nombrar los polígonos en el campo Tipo 

como “Pastizal”, “Cultivos” y “Bosque” según corresponda. 

- lago_laguna, en el campo Nombre llamar como “Laguna Santa Anilla”. 
 
 

 
8.2. Cálculo de área, perímetro y longitud 

 
Para calcular el área, el perímetro o la longitud de las distintas entidades es necesario tomar 

en cuenta la geometría de cada capa. Primero se debe asegurar que la capa participante 

posee un sistema de referencia definido. Es importante recordar que cuando se trabaja con 

shapefiles y se provocan cambios en la geometría, los campos de área, perímetro o longitud 

no se actualizan automáticamente. Es necesario recalcular los valores actuales después de 

cada cambio. 

 
Para iniciar, se hace clic derecho en la capa y se abre la tabla de atributos (p.ej. lago_laguna). 

Después hacer clic derecho en el encabezado del campo requerido (p.ej. Area) y seleccionar 

la herramienta “Calculate Geometry”. Finalmente, se selecciona la propiedad geométrica, el 

sistema de coordenadas y las unidades que desee utilizar (ver Figura 28; área en hectáreas). 

 
Práctica: Repetir el proceso y calcular el área en hectáreas de la capa cobertura_vegetal. 
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Figura 28. Cálculo de geometrías 
 
 

Con el mismo proceso expuesto en el párrafo anterior también se puede calcular el perímetro 

(p.ej. en metros) de la capa, solo se debe cambiar en la sección “Propery” de Area a 

Perimeter. Para las capas de polilíneas (p.ej. red_vial y red_hidrica) solo se puede calcular la 

longitud (p.ej. en metros) y para capas de puntos solo se puede calcular las coordenadas XY. 

En resumen, la herramienta “Calculate Geometry” permite calcular la geometría 

dependiendo de la naturaleza de cada capa. 

 
8.3. Cálculo de coordenadas XY 

 
La herramienta Add XY Coordinates permite calcular los valores de las coordenadas XY (si las 

capas poseen información Z = altura también se puede calcular). Para ejecutarla la 

herramienta se debe ir a la siguiente dirección: 

 
ArcToolbox > Data Management Tools > Features 

 
 

Figura 29. Agregar coordenadas XY 
 
 

En la sección “Input Features” primero se selecciona la capa (p. ej. edificaciones) y se acepta 

la selección presionando “OK” (Figura 29). Después se abre la tabla de atributos en donde se 
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puede ver que aumentaron los campos con los valores (XY) de las coordenadas. El mismo 

proceso se puede repetir para todas las capas de puntos (p.ej. sitios_seguros y 

puntos_hidrantes). 

 
8.4. Operaciones 

 
La calculadora de campos (“Field Calculator”) realiza cálculos simples y complejos, tanto para 

cadenas de texto como para operaciones matemáticas. Se debe tomar en cuenta que las 

operaciones afectan a todos los registros (si no hay ninguno seleccionado) o solo a los 

registros seleccionados. 

 
Si se requiere calcular el porcentaje de cada polígono con respecto a la superficie total (p.ej. 

capa cobertura_vegetal), primero se debe determinar el valor de la superficie total. Para 

ello se abre la tabla de atributos, hacer clic derecho sobre la cabecera del campo (Area), 

seleccionar Statistics y en la línea Sum se encuentra el área total de todos los polígonos de 

esta capa. Después se hace clic derecho sobre la cabecera del campo creado (Porcentaje), 

se selecciona la herramienta “Field Calculator” y se usa la siguiente expresión: [Area] * 100 

/ valor área total. La expresión [Area] en la ecuación corresponde al nombre del campo, lo 

cual se puede seleccionar directamente con doble clic sobre la sección “Fields” (Figura 30). 
 
 

Figura 30. Operaciones con Field Calculator 
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Las ecuaciones pueden contener diferentes operaciones matemáticas (suma, resta, división 

y multiplicación), incluyendo paréntesis. Los cálculos pueden desarrollarse por medio de VB 

Script o Python. Cuando se requiere acceder a las funciones de geoprocesamiento, incluido 

el cálculo de geometría de entidades, se recomienda usar Python. Además, este lenguaje 

proporciona mayores oportunidades para efectuar cálculos en secuencia de comandos. 

Mayor información acerca de la calculadora de campos se puede encontrar en About 

calculating fields, donde se encuentra una amplia lista de ejemplos disponibles (Figura 30). 

 
9. Herramientas de geoprocesamiento 

 
Sin duda, las herramientas SIG automatizan los procesos que antes tomaban mucho tiempo 

en ser desarrollados. En general las tareas manuales suelen requerir un gran esfuerzo para 

completarse. El geoprocesamiento es la ejecución metódica de una secuencia de operaciones 

en los datos geográficos para crear nueva información. Los dos propósitos fundamentales 

que persiguen estas herramientas son ayudar a realizar el modelamiento y el análisis, y 

automatizar las tareas SIG (ESRI, 2016b). 

 

A partir de ahora se usarán con mayor frecuencia las herramientas desde ArcToolbox ), 

aunque algunas de las herramientas más comunes de geoprocesamiento se pueden acceder 

desde el menú Geoprocessing. El uso de cada herramienta presenta una estructura similar: 

una ventana emergente solicita archivos de entrada y salida, aparte de campos configurables 

dependiendo de la naturaleza de la herramienta. 

 
9.1. Áreas de influencia (Buffer) 

 
Imaginemos por un instante que una gota de agua cae sobre una masa de agua y genera una 

onda expansiva. La onda se traslada y el fenómeno de propagación puede causar 

modificaciones de forma positiva o negativa desde su origen. Las zonas de influencia son 

polígonos creados a partir de una entidad a una distancia establecida. Este análisis espacial 

permite conocer la superficie afectada (p.ej. establecimiento de una fábrica), las zonas de 

influencia (p.ej. apertura de una vía dentro de un área protegida), la afectación por un 

contaminante (p.ej. fertilizantes), y el alcance de antenas (p.ej. telecomunicaciones o radares 

meteorológicos). 

 
 
 
 
 
 

35 

a
c
o

lit
a

.c
o

m
 



www.acolita.com/tienda 

 
 
 

Con la herramienta Buffer se pueden crear zonas de influencia para puntos, líneas y 

polígonos. La herramienta se encuentra disponible en la barra de menús Geoprocessing o en 

la siguiente dirección: 

 
ArcToolbox > Analysis Tools > Proximity > Buffer 

 

La configuración principal de la ventana 

emergente “Buffer” (Figura 31) se puede 

realizar de la siguiente manera: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figura 31. Configuración herramienta Buffer 

 

atributos. 

- Input Features.- Selecciona la capa 

de puntos, líneas o polígonos. 

- Output Features Class.- Selecciona 

el directorio o geodatabase donde se 

almacenará la entidad resultante. 

- Distance [value or field].- Presenta 

dos opciones: “Linear unit”, que permite 

establecer un valor fijo con su respectiva 

unidad (p.ej. metros), y “Field”, que crea 

una zona de influencia en base a los valores 

de un campo seleccionado de la tabla de 

- Method.- Especifica el método a usar para crear la zona de influencia. El método 

“Planar” usa la distancia euclidiana (cómo si se midiese con una regla en un plano 

proyectado), y “Geodesic” toma en cuenta la curvatura de la tierra 

independientemente del sistema de coordenadas de la capa. Las zonas de influencia 

no están influenciadas por la distorsión de un sistema de coordenadas proyectadas. 

 
La Figura 32 muestra un resultado de zonas de influencia para tres puntos, una línea y dos 

polígonos usando como distancia una unidad linear de 20 meteros y el método planar. 
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Figura 32. Zonas de influencia 
 
 

9.2. Intersecciones (Intersect) 

 
La intersección permite buscar el área de dos o más capas que se superponen. La herramienta 

Intersect calcula el área de intersección en una nueva capa. Para ejecutar la herramienta se 

debe dirigir a: 

 
ArcToolbox > Analysis Tools > Overlay > Intersect 

 

Se abre la ventana emergente de Intersect. En la sección Input Features se pueden añadir 

todas las capas en las que se requiere buscar áreas de intersección. Un ejemplo del resultado 

se puede observar en la Figura 33. 

 

Figura 33. Área de intersección 
 
 

9.3. Recortes (Clip) 

 
La herramienta Clip permite recortar parte de una entidad en base al perímetro de una capa 

poligonal (Figura 35). La capa poligonal se usa para limitar la extensión de las capas a un área 

específica. Por ejemplo, si cuenta con una capa de curvas de nivel de un país, se puede hacer 
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un recorte para trabajar a nivel de provincia. La herramienta se encuentra en la siguiente 

dirección: 

 
ArcToolbox > Analysis Tools > Extract > Clip 

 

Para configurar la herramienta se 

debe realizar el siguiente proceso 

(Figura 34): 

 
 
 
 
 
 

Figura 34. Herramienta Clip 

- Input Features.- Selecciona 

la capa de puntos, líneas o 

polígonos que se va a recortar. 

- Clip Features.- Selecciona la 

capa poligonal que contiene el perímetro de recorte. 

- Output Features Class.- Selecciona el directorio o geodatabase donde se guardará la 

nueva capa recortada. 

- XY Tolerance.- Es un parámetro opcional de tolerancia que establece la distancia que 

se puede mover una coordenada tanto en X como en Y. 

 
 

 
Figura 35. Recorte de entidades vectoriales 

 
 

9.4. Fusionar (Merge) 

 
Para fusionar dos o más entidades en una sola capa se puede emplear la herramienta Merge. 

Todas las entidades a fusionar deben ser del mismo tipo (puntos, líneas o polígonos). Se debe 

tener precaución porque esta herramienta no modifica la geometría de las entidades, incluso 

si existe solapamiento. La herramienta se encuentra en la siguiente dirección: 

 
ArcToolbox > Data Management Tools > General > Merge 

 

En la ventana emergente de Merge se encuentra la sección Input Dataset donde se 

seleccionan todas las capas a fusionar (se debe recordar que tienen que ser de la misma 
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geometría). En la sección Output Dataset se asigna un nombre y un directorio a la capa 

resultante. En la sección Field Map se añaden, renombran o eliminan los campos de las capas 

participantes. Un ejemplo se indica en la Figura 36, donde en la parte izquierda se encuentran 

dos capas de polígonos separados y en la parte derecha se muestra la fusión de ambas capas 

en una sola. 

 

Figura 36. Fusión de entidades 
 
 

9.5. Disolver (Dissolve) 

 
Esta herramienta unifica la información geográfica en base a un atributo, es decir realiza una 

fusión contigua de la información que comparte un valor idéntico dentro de la tabla de 

atributos. En la Figura 37 se puede ver que se fusionan todos los polígonos que contienen un 

atributo común. Por ejemplo, esta herramienta se usa cuando a partir de una capa de 

cantones se requiere obtener una capa de provincias. Aunque en este caso la tabla asociada 

a los cantones debe tener un campo que indique la provincia a la que pertenece cada cantón. 

Para abrir la herramienta Dissolve dirigirse a: 

 
ArcToolbox > Data Management Tools > Generalization > Dissolve 

 

En la ventana emergente de la herramienta Dissolve se deben configurar los parámetros de 

la siguiente manera: 

 
- Input Features.- Selecciona la capa de puntos, líneas o polígonos sobre la que se va 

a trabajar. 

- Output Features Class.- Selecciona el directorio o geodatabase donde se va a 

almacenar el archivo resultante. 

- Dissolve Field.- Selecciona el campo que contiene los atributos en función de los 

cuales se fusionarán las entidades. 

- Statistics Field.- Permite obtener cálculos estadísticos de los campos a disolver. 
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Figura 37. Disolver entidades 

 

10. Análisis espacial 

 
El análisis espacial es el proceso de modelar y obtener resultados mediante el procesamiento 

informático y luego examinar e interpretar los resultados del modelo. El análisis espacial 

resulta útil para evaluar la idoneidad y la capacidad, para calcular y predecir, y para 

interpretar y comprender los fenómenos espaciales (ESRI, 2016b). 

 
Se requiere una licencia de la extensión Spatial Analyst para poder ejecutar las herramientas 

que se emplearán en este apartado. 

 
10.1. Interpolaciones 

 
La primera ley de la geografía de Tobler (1970) establece: Todos los lugares están 

relacionados, pero los lugares cercanos están más relacionados que los lugares lejanos. Por 

ejemplo, si llueve a un lado de una calle es altamente probable que también llueva al otro 

lado de la calle. 

 
De acuerdo a Gruver & Dutton (2014) la interpolación es un proceso que utiliza mediciones 

realizadas sobre algún fenómeno (precipitación, temperatura, elevación) en determinados 

lugares (muestras o estaciones) para hacer una predicción sobre este fenómeno en lugares 

donde no se han realizado mediciones. 

 
Existen muchos métodos de interpolación, de los cuales algunos cuentan con más presencia 

en los SIG por estar más adaptados al tipo de dato que se maneja. Su aplicación habitual 

dentro de un SIG es bidimensional, ya que una capa ráster es una entidad de este tipo. 

Hablamos, por ello, de interpolación espacial. No obstante, estos métodos no solo se 

restringen al plano, sino pueden extenderse a un número superior de dimensiones para 

reflejar otras variables tales como la profundidad (por ejemplo, para construir un modelo 
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tridimensional de las características del suelo entre dos profundidades establecidas y con un 

intervalo dado), o también el tiempo (Olaya, Sistemas de Información Geográfica, 2014). 

 
Las técnicas de interpolación mencionadas por (Childs, 2004) son: determinísticas y 

geoestadísticas. La técnica de interpolación determinística crea superficies basadas sobre 

puntos medidos o funciones matemáticas. Métodos como la Distancia Inversa Ponderada 

(IDW = Inverse Distance Weighting) son basados en el grado de similitud de las celdas, 

mientras que métodos como Trend adapta a una superficie lisa determinada por una función 

matemática. La técnica de interpolación geoestadística, como Kriging, se basa en estadísticas 

y son usadas para la predicción más avanzada de modelamiento de superficies, que también 

incluye cierto grado de certeza o exactitud de las predicciones. Existen distintas 

clasificaciones de los métodos de interpolación, algunas de las cuales se pueden consultar en 

(Olaya, Sistemas de Información Geográfica, 2014). 

 
Sin entrar a más detalles sobre los distintos métodos de interpolación, todos estos se 

encuentran disponibles en la siguiente dirección: ArcToolbox > Spatial Analyst Tools > 

Interpolation. 

 
La Tabla 3 contiene datos de precipitación de estaciones meteorológicas ubicadas en 

diferentes puntos. La idea central es construir una superficie ráster con valores estimados de 

la precipitación para lugares donde no existen estaciones meteorológicas. 

 
Tabla 3. Datos de precipitación y temperatura mensual de una red de estaciones 

meteorológicas 

Estación UTM_X UTM_Y UTM_Z Precipitación (mm) Temperatura (°C) 

A 694294 9558872 2377 89.4 13.13 

B 697901 9563240 2033 40.2 15.51 

C 700975 9560679 2218 53.1 14.23 

D 694716 9555060 2816 75.9 11.17 

E 692138 9559012 2952 72.8 11.07 

F 706230 9560170 2850 102.4 10.34 

G 699711 9553629 2160 72.5 14.59 

 
 

Sin embargo, para interpolar los datos es necesario tener un shapefile o una capa vectorial 

de puntos. En caso de no existir la capa de puntos se pueden importar coordenadas XY y 

transformarlas a un shapefile. En ArcGIS se admite diferentes formatos de tablas como 

archivos de Excel 97-2003, texto delimitado por tabulaciones, DBF, y CSV. 
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Práctica: Agregar coordenadas XY y exportarlas como shapefile 
 

En una nueva ventana de ArcMap, desde la barra de menús dirigirse a File > Add Data > Add 

XY Data. En la ventana emergente que aparece se debe configurar los campos de la siguiente 

manera: 

 
- Choose a table from the map or browse for another table.- Seleccionar la tabla que 

contiene los datos de precipitación. Información de la Tabla 3 almacenada como un 

archivo XLS (Libro de Excel 97-2003). 

- X Field.- Selecciona el campo que contiene los valores de longitud (UTM_X). 

- Y Field.- Selecciona el campo que contiene los valores de latitud (UTM_Y). 

- Z Field.- Es opcional, pero se puede seleccionar el campo que contiene los valores de 

altitud (UTM_Z). 

- Coordinate System of Input Coordinates.- En el botón Edit seleccionar el sistema de 

coordenadas, en este caso Projected Coordinate Systems > UTM > WGS 1984 > 

Southern Hemisphere > WGS 1984 UTM Zone 17S. 

 
Este proceso genera una capa de eventos, sin embargo, para tener esta capa almacenada en 

el disco duro en formato shapefile se requiere seguir los siguientes pasos: Se debe hacer clic 

derecho sobre la capa en la tabla de contenidos e ir a Data > Export Data. Allí se abre una 

ventana emergente donde se selecciona la dirección y nombre del archivo a guardar. Si no 

permite guardar el archivo en formato shapefile, se debe verificar que el tipo del formato fue 

seleccionado correctamente (en Save as type). Este paso es necesario para tener información 

almacenada en un shapefile. 

 
De las varias opciones de interpolación que permite ArcGIS, el método que se va a utilizar 

aquí para interpolar la precipitación es el método Kriging. Este se encuentra ubicado en la 

siguiente dirección: 

 
ArcToolbox > Spatial Analyst Tools > Interpolation > Kriging 

 

La velocidad de ejecución del proceso depende de la cantidad de puntos a procesar y los 

recursos disponibles del sistema. La ventana emergente de configuración en todas las 

herramientas de interpolación presenta un aspecto similar. Un ejemplo de los parámetros 

que requiere la herramienta, en este caso Kriging (Figura 38) se describen a continuación: 
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- Input point features.- Selecciona la capa de puntos que contiene los valores de 

precipitación (p.ej. shapefile creado a partir de la Tabla 3). 

- Z value field.- Selecciona el campo que almacena los valores de precipitación. 

- Output surface raster.- Selecciona un directorio o geodatabase para almacenar el 

archivo ráster de salida. 

- Semivariogram properties.- Permite seleccionar el método de interpolación de 

Kriging con su respectivo semivariograma. 

- Output cell size.- Establece el tamaño de celda (resolución del mapa resultante). 

- Search radius.- Establece los puntos de entrada para interpolar cada celda. 

- Output variance of prediction raster.- Es un ráster opcional que contiene los valores 

de semivarianza. 

 

Figura 38. Configuración de parámetros de la herramienta Kriging 
 
 

La Figura 39 indica los resultados de la interpolación en una superficie ráster con valores 

estimados. En la parte izquierda se pueden ver los puntos donde están ubicadas las 

estaciones meteorológicas (convertido al formato shapefile). En el lado derecho se puede ver 

el mapa resultante de la interpolación como imagen ráster, incluyendo los valores estimados 

de precipitación para cada celda. El mismo proceso se puede repetir para obtener una 

imagen ráster de temperatura usando los valores de la Tabla 3. 
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Figura 39. Interpolación de precipitaciones. Puntos de las estaciones meteorológicas (izquierda) y superficie de 

predicción interpolada (derecha). 

 
10.2. Modelos digitales de elevación 

 
Un Modelo Digital de Elevación (DEM = Digital Elevation Model) es una representación en 

formato ráster de una superficie continua. Por lo general hace referencia a la superficie de la 

tierra, mediante un conjunto de puntos cuyos valores en X, Y y Z son conocidos y están 

definidos en un sistema de coordenadas arbitrario (Fallas, 2007). 

 
La información que se puede derivar a partir de modelos digitales de elevación tiene 

aplicabilidad en diferentes campos, como la hidrología, análisis de riesgos, la planificación 

urbana, entre otros. Los principales productos que se pueden obtener de un DEM son: mapas 

de pendientes, curvas de nivel, mapa de relieve, mapa de visibilidad, mapa de aspecto, 

cuencas hidrográficas, cuencas visuales, etc. 

 
 
 

 

Figura 40. Modelo digital de Elevaciones 
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10.3. Creación de mapas de pendientes 

 
La pendiente es el factor principal que determina y diferencia las formas del relieve. Dados 

dos puntos de diferente altitud entre sí, se entiende como pendiente del terreno a la razón 

matemática determinada por la relación proporcional que existe entre la diferencia de altitud 

y la distancia horizontal entre ambos puntos (Hernández, 1998). 

 
La pendiente se puede expresar en porcentaje o grados sexagesimales. Para crear un ráster 

de pendiente se requiere de un DEM como información de entrada, y la herramienta Slope 

para generar el ráster de pendiente, la cual está ubicada en: 

 
ArcToolbox > Spatial Analyst Tools > Surface > Slope 

 
 

Figura 41. Configuración de parámetros de la herramienta Slope 
 
 

La configuración de la herramienta Slope (Figura 41) se describe a continuación: 
 

- Input raster.- Selecciona la capa que contiene un DEM. 

- Output raster.- Selecciona un directorio o geodatabase para almacenar el archivo 

ráster de pendientes. 

- Output measurement.- Selecciona “DEGREE” para grados decimales, y 

“PERCENT_RISE” para porcentaje. 

- Z factor.- Es un factor opcional, se usa para que las unidades lineales Z coincidan con 

las unidades lineales XY. 
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Figura 42. Ráster de pendientes en grados 

 

10.4. Reclasificaciones 

 
La herramienta Reclassify permite reclasificar los valores de un ráster, es decir reemplaza los 

valores actuales de cada celda, por nueva información. Se pueden reclasificar datos de 

cualquier variable almacenada en formato ráster (pendiente, elevación, precipitación, 

temperatura, etc.). 

 
Práctica: Construir un mapa de pendiente basado en la clasificación propuesta por la FAO 

(2009) se debe reagrupar en clases los valores del ráster de pendientes (p.ej. Figura 42). La 

Tabla 4 presenta ocho clases, cada una de las clases contiene los valores de pendiente en 

porcentaje y grados decimales. 

 
Tabla 4. Clases de gradiente de la pendiente 

 

Clase* Descripción Porcentaje Grados 

01 Plano 0 - 1 0 - 0.57 

02 Muy ligeramente inclinado 1 - 2 0.57 - 1.15 

03 Ligeramente inclinado 2 - 5 1.15 - 2.86 

04 Inclinado 5 -10 2.86 - 5.71 

05 Fuertemente inclinado 10 - 15 5.71 - 8.53 

06 Moderadamente escarpado 15 - 30 8.53 - 16.70 

07 Escarpado 30 - 60 16.70 - 30.96 

08 Muy escarpado > 60 > 30.96 
* La clase 01 es un consolidado de las tres primeras clases de gradiente de (FAO, 2009). 

 
 

Para ejecutar la reclasificación abrir la herramienta Reclassify en la siguiente dirección: 
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ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify 
 
 

Figura 43. Configuración de parámetros de la herramienta Reclassify 
 
 

En la ventana emergente se debe configurar los parámetros que se describen a continuación 

(Figura 43): 

 
- Input raster.- Selecciona la capa que contiene el ráster de pendientes. 

- Reclass field.- Selecciona el campo que contiene los valores de pendiente, por 

defecto suele ser VALUE. 

- Reclassification.- Dentro de esta sección al hacer clic en el botón Classify, lo cual 

abre una ventana de clasificación, donde se pueden ajustar los valores de las clases. 

En la sección Classification de ventana de clasificación se puede seleccionar el 

método de clasificación y definir el número de clases (8). En la parte inferior derecha 

en la sección Break Values se pueden ingresar manualmente los límites de cada clase 

(p.ej. valores de pendiente en porcentaje de la Tabla 4). 

- Output ráster.- Selecciona un directorio o geodatabase para almacenar el archivo 

ráster reclasificado de pendiente. 
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Figura 44. Ráster de pendiente reclasificado 
 
 

10.5. Generación de contornos 

 
Los contornos son líneas que conectan puntos de igual valor que representan fenómenos 

continuos (Huisman & A. de By, 2009). Los contornos se denominan isolíneas, pero también 

pueden tener términos específicos según el fenómeno. Cuando se las usa para representar 

la elevación se denominan curvas de nivel (Figura 45), isobaras para la presión atmosférica, 

isoyetas para la precipitación, isotermas para la temperatura o isócronas para el tiempo 

(Olaya, Sistemas de Información Geográfica, 2014). 

 

Figura 45. Curvas de nivel (msnm) 
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El proceso para generar isolíneas de todo tipo es similar. Si se requiere crear curvas de nivel 

se necesita de un DEM como información de entrada. Las isolíneas se generan con la 

herramienta Contour, ubicada en: 

 
ArcToolbox > Spatial Analyst Tools > Surface 

 
 

Figura 46. Configuración de los parámetros de la herramienta Contour 
 
 

La configuración de los parámetros de la herramienta Contour (Figura 46) se detalla a 

continuación: 

 
- Input raster.- Selecciona el ráster que contiene los valores (para generar curvas de 

nivel se requiere un ráster DEM, isoyetas un ráster de precipitación, para isotermas 

un ráster de temperatura). 

- Output polyline features.- Selecciona el directorio o geodatabase para almacenar la 

capa de líneas (curvas de nivel). 

- Contour interval.- Defini el intervalo entre isolíneas. Es importante tomar en cuenta 

la resolución del ráster, por ejemplo, si el DEM tiene una resolución de 30 metros, 

no se recomienda crear curvas de nivel menores a 30 metros. 

- Base contour.- Opcionalmente se puede asignar un valor de nivel base. 

- Z factor.- Opcionalmente se puede asignar un factor de conversión para generar la 

isolíneas. Se usa para realizar conversiones de unidades (de metros a pies). 

 
10.6. Algebra de mapas 

 
La calculadora de capas ráster (o simplemente calculadora ráster) está creada para ejecutar 

expresiones algebraicas utilizando varias herramientas y operadores mediante la interfaz de 
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la herramienta de una calculadora simple (herramienta Raster Calculator). El rendimiento de 

las ecuaciones depende de las herramientas u operadores participantes en una expresión. 

En general, el procesamiento de los datos es más rápido si se ejecutan cada uno de los 

operadores o herramientas de forma individual (ESRI, 2016c). La versatilidad del algebra de 

mapas radica en su sencillez y potencia para realizar análisis geográfico. 

 
Una capa ráster puede ser creada a partir de un algoritmo de asignación de valores numéricos 

a los píxeles que la componen o puede ser derivada a partir de una o varias capas ráster 

previamente existentes. Un ejemplo simple se indica en la Figura 47, en la parte izquierda se 

tiene el mapa raster inicial, a lo cual se quiere ejecutar una operación simple, que consiste 

en multiplicar a todos los píxeles de la capa con el factor 5. El resultado se almacena en una 

nueva capa ráster (Figura 47 derecha). 

 

 

Figura 47. Funcionamiento básico de algebra de mapas 
 
 

Práctica: A partir de los datos de la Tabla 3 crear una imagen ráster interpolando los valores 

de temperatura (ver Figura 49 izquierda), para ello seguir los pasos del apartado 10.1. La idea 

de este ejercicio es familiarizarse con el uso de expresiones algebraicas por medio de la 

calculadora ráster (Raster Calculator). La capa ráster de temperatura se genera en Grados 

Celsius, pero se requiere convertir los valores a Grados Fahrenheit (ver Figura 49 derecha). 

Se debe aplicar la siguiente ecuación dentro de la calculadora de imágenes ráster: 

 

 

� = (� ∗  
9 
) + 32 

5 

 

dónde: 

 

F = Temperatura en grados Fahrenheit 

C = Temperatura en grados Celsius 

La herramienta Raster Calculator para ejecutar expresiones de algebra de mapas se 

encuentra en: 
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ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster Calculator 
 
 

Figura 48. Configuración de expresiones en Raster Calculator 
 
 

La descripción de la herramienta Raster Calculator (Figura 48) se presenta a continuación: 
 

- Layers and variables.- Muestra una lista de capas disponibles para usar en la 

expresión de algebra de mapas. 

- Operadores.- Permite introducir operaciones matemáticas y lógicas en la expresión. 

Hacer un clic sobre el botón de la calculadora para introducir el número u operador 

dentro de la expresión. 

- Herramientas.- Muestra una lista de herramientas (seno, coseno, tangente) para 

usar en cualquier parte de la expresión. 

- Expresión.- Permite crear un conjunto de reglas para ejecutar una expresión válida. 

No es necesario colocar al inicio de la expresión el signo “igual” (=). En la ecuación 

para convertir grados Celsius a Fahrenheit reemplazar “C” por el nombre de la 

imagen ráster: “T_°C” * 9 / 5 + 32. Use paréntesis para agrupar expresiones 

algebraicas. 

- Output raster.- Selecciona un directorio o geodatabase para almacenar el archivo 

ráster generado por la expresión resultante. 
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Figura 49. Ráster de temperatura en °C (izquierda). Ráster de temperatura en °F obtenido a través de una 

expresión de algebra de mapas (derecha). 

 
10.7. Perfiles topográficos 

 
Un perfil topográfico o perfil de elevación es un corte transversal bidimensional del terreno. 

Es una vista lateral del terreno representada a través de una línea trazada entre dos o más 

puntos en un mapa. El eje Y corresponde a los valores de altitud o elevación, mientras que el 

eje X corresponde a los valores de la distancia entre estos puntos. 

 
Elaborar un perfil topográfico puede resultar sencillo, pero realizar un gráfico atractivo y 

elegante es una tarea laboriosa. En ArcMap se puede generar gráficos simples, pero con la 

ayuda de Microsoft Excel se puede mejorar notablemente el diseño final del gráfico. 

 
Práctica: Crear un perfil topográfico de varios puntos que corresponden a sitios poblados. 

Las principales actividades a desarrollar en esta práctica son: 

 
 Crear un Profile Graph y Point Profile en ArcMap. 

 Exportar la tabla del perfil creada hacia Excel. 

 Crear un gráfico de dispersión (XY) con las dos series de datos (Profile Graph y Point 

Profile) en Excel. 

 Agregar etiquetas, y afinar detalles y diseño del gráfico con las opciones de formato 

en Excel. 

 
El primer paso consiste en añadir un DEM y una capa de puntos dentro de ArcMap (Figura 

50). La capa de puntos corresponde a poblados que existen en la zona. 
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Figura 50. Modelo de Elevación Digital (DEM) con una capa de puntos 
 
 

Si los puntos se encuentran solo en 2D (coordinadas XY), es necesario convertir estos puntos 

vectoriales en 3D para obtener los valores Z (altura) de los puntos. Para esto se requiere de 

un DEM, de donde se puede extraer la información altitudinal de cada punto. Se debe 

dirigirse a: 

 
ArcToolbox > 3D Analyst Tools > Functional Surface > Add Surface Information 

 

Figura 51. Configuración de la herramienta Add Surface Information 
 
 

La ventana "Add Surface Information", que se muestra en la Figura 51, se debe configurar de 

la siguiente manera: 
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- Input Feature Class.- Ingrese la capa de puntos (Profile_points). 

- Input Surface.- Ingrese el modelo de elevación digital (Loja17S.img). 

- Output Property.- Marque la casilla Z. 
 

Hacer un clic en "OK" y después abriendo la tabla de atributos de la capa de puntos se puede 

ver los valores Z en un nuevo campo. Para convertir los puntos de 2D a 3D debe dirigirse a la 

siguiente dirección: 

 
ArcToolbox > 3D Analyst Tools > 3D Features > Feature To 3D By Attribute 

 

Figura 52. Configuración de la herramienta Feature To 3D By Attribute 
 
 

La ventana de la herramienta "Feature To 3D By Attribute" (Figura 52) se debe configurar de 

la siguiente manera: 

 
- Input Features: Ingrese la capa de puntos (Profile_points). 

- Output Feature Class: Asigne un nombre a la capa de salida (Profile_points_3D). 

- Height Field: Seleccione el campo que contiene los valores de Z. 
 

Una vez configurado la capa de puntos, se puede crear un gráfico de perfil en base a los 

puntos. Para generar el gráfico de perfil (Profile Graph) se debe realizar los siguientes pasos: 

 
- Primero asegurarse de activar la barra de herramientas 3D Analyst (Menú Customize 

> Toolbars). Luego, hacer clic en el ícono Interpolate line ). 

- Con esta herramienta puede dibujar libremente la línea del perfil topográfico. Para 

crear esta línea es muy importante tomar en cuenta la dirección, de izquierda a 
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derecha o viceversa, porque la herramienta "Profile Graph" se trazará según la 

dirección del punto de inicio. En este ejemplo se utilizó en sentido izquierda a 

derecha. 

- Una vez que se haya creado la línea del perfil, en la barra de herramientas 3D Analyst 

se debe hacer clic en el botón Profile Graph ). Aquí, debe aparecer un gráfico de 

perfil como se muestra en la Figura 53. 

 

Figura 53. Creación de un perfil de elevación con la herramienta Profile Graph 
 
 

Ahora se requiere crear un nuevo gráfico usando la capa de puntos. Para ello debe realizar 

los siguientes pasos: 

 

- En la barra de herramientas 3D Analyst de clic en el ícono Point Profile ). 

- Dibuje una nueva línea con la misma longitud y la dirección que la primera línea roja 

(se recomienda ser preciso, pero no hay problema si no se consigue obtener una 

línea exactamente igual a la primera). Se recomienda dar el primer clic en el inicio de 

la primera línea (roja), el segundo clic al final de la línea. A continuación, debe mover 

el puntero del ratón hacia arriba o hacia abajo dibujando un área que incluya todos 

los puntos deseados (recuadro negro). Para finalizar se hace un tercer clic para crear 

el Point Profile, se recomienda fijarse en la Figura 54. 
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Figura 54. Creación de un perfil de elevación con la herramienta Point Profile 
 
 

Hasta el momento ya se han creado los perfiles de elevación en ArcMap. Sin embargo, para 

mejorar la presentación y tener un diseño más atractivo y elegante se debería exportar los 

datos hacia Microsoft Excel. Esto se hace de la siguiente manera: 

 
- Desde ArcMap, debe dar clic derecho sobre el primer gráfico Profile Graph > 

Advanced properties. 

- En la nueva ventana, de clic en Data, luego clic sobre el botón Copy ( ). 

- Una vez en Excel, debe pegar los datos en un nuevo libro. 

- Luego, debe repetir el proceso con el segundo gráfico de perfil de puntos (ver Figura 

55). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Ejercicios disponibles en: www.acolita.com/producto/ejercicios-fundamentos-sig/ 

http://www.acolita.com/tienda
http://www.acolita.com/producto/ejercicios-fundamentos-sig/


 
 

Figura 55. Opciones avanzadas del gráfico de perfil 
 
 

Una vez que se cuenta todos los datos de los perfiles dentro de Excel, se debe agregar las 

etiquetas de los puntos (Figura 56). En nuestro ejemplo, estos son nombres de ciudades. 

Existen algunas opciones para obtener las etiquetas de nuestro gráfico, por ejemplo: 

 
- Se puede escribir estos nombres de forma manual en una nueva columna en Excel. 

- Se puede obtener las etiquetas abriendo directamente el archivo * .dbf en Excel, y 

copiando estos nombres en una nueva columna. 

 

Figura 56. Datos de los perfiles de elevación dentro de Excel 
 
 

Para tener una mejor apariencia del gráfico de perfil, es necesario preparar los datos. Dos 

pasos son suficientes: transformar los valores de X que son la escala de longitud de metros a 

kilómetros, y suavizar los datos Y de la línea de elevación de la siguiente manera: 

 
- Primero, se debe transformar los valores de longitud en metros a kilómetros. Esto es 

muy fácil, se lo puede hacer en una nueva columna dividiendo los valores de X para 

mil. Por ejemplo. En la celda D2 escribir: =B2/1000. Lo mismo para los valores de 

longitud del Point Profile, en una nueva columna =H2/1000. 
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- Segundo, se debe hacer un suavizado de la línea del perfil a partir de sus datos. Esto 

es básicamente para mostrar los patrones más importantes o la tendencia de la línea 

del perfil removiendo los detalles más finos. En otras palabras, es tener una línea 

suavizada del perfil de elevación. Hay muchos métodos para realizar esta tarea, pero 

en nuestro ejemplo utilizamos un método simple calculando promedios en Excel. Sin 

embargo, recuerde que puede utilizar cualquier otra técnica. A continuación, se 

calcula promedios consecutivos en conjuntos de 100 filas (u otro número de filas de 

acuerdo a grado de suavizado que se desee). Las filas se pueden cambiar en función 

de la longitud del perfil de elevación, o según la fuerza del suavizado requerido. Por 

ejemplo. En una columna vacía, en la primera fila (E2), se puede utilizar esta fórmula: 

=PROMEDIO(C2:C101), posteriormente arrastrar hacia todas las celdas de la columna 

(ver Figura 57). 

 

Figura 57. Suavizado de datos en Microsoft Excel 
 
 

Para el ploteado de gráficos de Excel, se inserta un nuevo diagrama de dispersión (X, Y): 
 

- Seleccione dos columnas: Longitud (como eje X) y elevación (como eje Y). En nuestro 

ejemplo son las columnas D y E. 

- Ir a al menú Insertar > Gráficos > Dispersión con líneas suavizadas. En la Figura 58 se 

muestra la línea del perfil de elevación suavizada. 
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Figura 58. Ploteado de gráficos de dispersión en Microsoft Excel 
 
 

Para agregar una nueva serie que contenga los puntos con sus ubicaciones dentro del mismo 

gráfico, debe efectuar lo siguiente: 

 
- Clic derecho sobre el gráfico > Seleccionar datos… 

- Clic en Agregar. 

- Coloque un nuevo nombre en Nombres de la serie: (En este caso “Sites”). 

- En “Valores X de la serie:” seleccione los valores X del segundo gráfico (En este caso 

la columna “Length2 (Km)” =Hoja1!$I$2:$I$11 ). 

- En “Valores Y de la serie:” seleccione los valores Y del segundo gráfico (En este caso 

la columna “Point Profile” =Hoja1!$J$2:$J$11). 

- Se agrega una segunda línea en el gráfico (Figura 59), pero todavía no se encuentra 

lista. 

 

Figura 59. Gráfico de dispersión que incluye dos series 
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Se debe cambiar el gráfico de la segunda línea (Sites) a puntos por medio de las indicaciones 

que se muestran en la Figura 60: 

 
- Seleccione la línea recientemente agregada (naranja). 

- Con clic derecho seleccione Cambiar tipo de gráfico de series… 

- Clic en el nombre de la segunda serie (Sites). 

- Clic en el menú desplegable. 

- Clic sobre el tipo de gráfico llamado “Dispersión”. 
 
 

Figura 60. Cambio del tipo de gráfico, de líneas a puntos 
 
 

El perfil de elevación está casi listo, pero los nombres de los puntos aún no se muestran. Para 

añadir las etiquetas se debe realizar las siguientes acciones (Figura 61): 

 
- Seleccione la serie de puntos (“Sites”) 

- Vaya al menú Diseño > Agregar elemento de gráfico > Etiquetas de datos > Más 

opciones de la etiqueta de datos… 

- Seleccione Valores de las celdas del panel derecho en las opciones de etiqueta. 

- Seleccione la columna que contiene las etiquetas (=Hoja1!$K$2:$K$11). 

- Desactive la casilla “Valor Y”. 
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Figura 61. Añadir etiquetas a la información de puntos 
 
 

Finalmente, luego de un proceso laborioso el perfil topográfico o perfil de elevación está listo, 

incluyendo todos los puntos y sus ubicaciones (Figura 62). Adicionalmente, se puede seguir 

mejorando el gráfico personalizando las siguientes características: 

 
- Título, leyenda, 

- Color y tamaño del texto, 

- Títulos de los ejes, 

- También puede personalizar la línea de perfil con un color degradado (como en 

nuestro ejemplo, la línea del perfil va de naranja a verde) 

- Eliminar las líneas de división internas, ajustar la escala, etc. 
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Figura 62. Perfil topográfico o de elevación 

 

11. Diseño y publicación 

 
El diseño de mapas puede convertirse en un proceso laborioso hasta que el resultado sea 

satisfactorio. Ver los datos para analizar e interpretar la información espacial en una 

computadora es una cosa, pero imprimir un mapa para que otras personas lo analicen e 

interpreten es distinto. ArcMap pone a disposición una serie de herramientas para el diseño 

de mapas antes de su publicación (Hillier, 2011). En general, un mapa mientras más sencillo 

sea, es más fácil de comprender. Esto implica evitar contenido innecesario, seleccionar 

colores adecuados, el tamaño de texto correcto y priorizar la información según su 

relevancia. Es decir, no se trata solo crear un mapa agradable a la vista, sino de que pueda 

transmitir el propósito para el cual fue diseñado. 

 
Un mapa es una representación o percepción incompleta del territorio. El mapa ofrece a los 

ojos del público sólo lo que el cartógrafo quiere mostrar. Quien lo dibuja selecciona de 

manera razonada los elementos que desea cartografiar, pero su elección depende de sus 

propios conocimientos, de su sensibilidad y de sus intenciones (Rekacewicz, 2006). 

 
11.1. Simbología de puntos, líneas y polígonos 

 
La simbología permite definir cómo se visualizará cada elemento en el mapa (símbolos, 

colores, tramas, texto). En la simbología se debe considerar si se requiere o no mostrar la 

información acorde a la tabla de atributos de cada capa. 
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Para configurar la simbología de las capas creadas en el apartado 7.1 se debe hacer clic 

derecho sobre la capa a personalizar (edificaciones), seleccionar Properties, y ubicarse en la 

pestaña Symbology. 

 

Figura 63. Pestaña Symbology de las propiedades de una capa 
 
 

En la pestaña Symbology, para representar la información geográfica se debe tomar en 

cuenta los siguientes aspectos para su configuración: 

 
- Show.- Se encuentra en la parte izquierda de la ventana. Permite organizar la 

información individualmente, por categorías, números, gráficos y múltiples 

atributos. Para el caso de la capa edificaciones seleccionar Categories > Unique 

values. 

- Valued Field.- Selecciona el campo Tipo para representar en categorías la 

información almacenada dentro de ese mismo campo. Al hacer clic en Add All Values 

se añaden todas las categorías, Add Values de forma individual, Remove elimina la 

categoría seleccionada y Remove All elimina todas las categorías adicionadas. 

- Color Ramp.- Se puede seleccionar una paleta de colores predeterminados. 
 

Cuando se añaden todas las categorías de una capa, por defecto se adiciona <all other 

values>, se recomienda desactivar aquella casilla. También se puede eliminar la etiqueta 

(Tipo) de la cabecera <Heading> (ver Figura 63). Para ver los cambios en la tabla de 
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contenidos se hace clic en Apply y para aceptarlos en OK. Se recomienda ordenar las capas 

de acuerdo a su geometría dentro de la tabla de contenidos. 

 
El mismo procedimiento se puede aplicar a las capas red_vial y cobertura_vegetal para 

agregar todas sus categorías en base a la información que contiene la tabla de atributos. 

 

Figura 64. Configuración de la Tabla de Contenidos 
 
 

En la tabla de contenidos, el botón List By Drawing Order ) debe estar activado para 

arrastrar y soltar las capas en el orden requerido (p.ej. la parte inferior los polígonos, 

posteriormente las líneas y sobre todas las capas los puntos). 
 

Por defecto cada capa tiene exactamente el mismo nombre del archivo (Figura 64 izquierda) 

y cada categoría tiene el nombre de acuerdo a la tabla de atributos (Figura 64 centro) Para 

editar el nombre de una capa o categoría se hace un clic sobre ella y se puede cambiarlo 

individualmente. Es importante revisar que todo se encuentre escrito correctamente (Figura 

64 derecha), porque la leyenda del mapa mostrará aquellos nombres. 

 
Cuando se carga por primera vez una capa en ArcMap este asigna símbolos del mismo 

tamaño, forma y color (Single Symbol). Para representar el mundo real a través de un mapa, 

es necesario emplear símbolos adecuados que puedan representar apropiadamente la 

naturaleza de la información. 
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ArcMap contiene una amplia biblioteca de símbolos usados en diversas disciplinas. Se debe 

elegir cuidadosamente el símbolo que transmita lo que realmente se necesita representar. 

El símbolo de cada punto en la lista se puede clasificar individualmente. Por ejemplo, para 

personalizar el símbolo Escuela (de la capa de puntos Edificaciones) se debe realizar los 

siguientes pasos (Figura 65). 

 
- Doble clic sobre la capa. 

- Doble clic sobre el símbolo en la lista. 

- En la ventana Symbol Selector hacer clic en el botón Style Reference. 

- Activa la casilla Civic (o las bibliotecas de símbolos requeridas). 

- En Symbol Selector seleccionar el símbolo School 1. 

- En el botón Color seleccionar el color negro de la lista desplegable (para personalizar 

hacer clic en More Colors, en la ventana Color Selector se pueden personalizar los 

valores RGB). 

- En el botón Size seleccionar el tamaño del símbolo de la capa de puntos. En el caso 

de líneas Width para el ancho de línea, para polígonos Outline Width para el ancho 

de la línea de contorno y Outline Color para el color de la línea de contorno. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figura 65. Biblioteca de símbolos de ArcMap 

 
 

Para las capas restantes, asignar la simbología de acuerdo a la Tabla 5 en base al proceso 

descrito en el párrafo anterior. 
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Tabla 5. Definición de propiedades de los símbolos 
 

Shapefile Categoría Símbolo Color RGB Tamaño de 

símbolo o 

ancho de 

línea 

edificaciones Escuela 

Hospital 

Iglesia 

Vivienda 

School 1 

Hospital 1 

Place of Worship 

1 

Building 1 

0,0,0 

255,255,255 

0,0,0 

255,255,255 

18 

14 

18 

8 

puntos_hidrantes Puntos 

hidrantes 

Faucet 0,0,0 18 

sitios_seguros Sitios seguros Rnd Square 1 0,0,0 14 

red_vial Calle 

Sendero 

Vía lastrada 

Vía principal 

Road, Proposed 

Dashed 4:4 

Road, Unpaved 

Highway 

255,55,55 

0,0,0 

115,76,0 

250,52,17 

1 

0.40 

2 

1.70 

red_hidrica Red hídrica River 10,147,252 1 

cobertura_vegetal Bosques 

Cultivos 

Pastizal 

Scattered Trees 1 

Cropland 

Grassland 

109,187,67 

227,158,0 

109,187,67 

0.40 

0.40 

0.40 

lago_laguna Laguna Lake 151,219,242 0.40 

 
 

11.2. Diseño del mapa 

 
Resulta imposible transponer todo lo que se encuentra en el mundo real, por ello quien tome 

un mapa no tienen otra opción que creer en el mismo. El cartógrafo es totalmente libre de 

transcribir el mundo como mejor le parece (Rekacewicz, 2006), pero al plasmar la realidad 

no se debe sesgar ni manipular la información, sino mantener la imparcialidad en todo lo 

posible. 

 
La distribución de los elementos de un mapa está sujeta a los requerimientos del autor. Lo 

importante es que un mapa pueda ser entendido por el público al cual va dirigido. En la Figura 

66 se sugiere la disposición de los elementos del mapa, aunque no todos los elementos son 

obligatorios, al menos debe contener el título, grilla, norte geográfico, escala, y leyenda. 
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Figura 66. Elementos para diseñar un mapa 
 
 

Antes de iniciar con el diseño del mapa, se recomienda configurar la orientación y el tamaño 

del papel. Desde el menú File debe dirigirse a Page and Print Setup para seleccionar la 

impresora. En la sección Paper > Size se elige el tamaño (p.ej. papel A4) y la orientación 

(Orientation > Landscape para orientar la hoja horizontalmente; Portrait para vertical). 

 
Desde el menú Customize > Toolbars activar la barra de herramientas Draw (Figura 67), 

porque contiene herramientas para agregar y editar elementos gráficos en el Layout. 

 

Figura 67. Barra de herramientas Draw 
 
 

Para empezar a diseñar el mapa se debe cambiar la pantalla Data View a Layout View desde 

el menú View, o usando los botones que se muestran en la Figura 1. Es importante indicar; 

lo que se ve en el Layout View es como se observará al momento de imprimir o exportar el 

mapa. 

 
La configuración de los elementos de la Figura 66 se detallan a continuación: 
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Título (1) 
 

En el menú Insert seleccionar Title, en el cuadro de diálogo definir el título como: Mi primer 

mapa. 

 
Cuerpo del mapa (2) 

 

Automáticamente al pasar a la pantalla de Layout View se muestra por defecto el marco de 

datos. El cuerpo del mapa es la parte fundamental de un mapa. Contiene todas las capas a 

representar dentro de un mapa. Para reducir o ampliar el cuerpo del mapa, haga clic sobre 

el rectángulo de mapa y ajuste las bordes según lo requiera. 

 
Grilla (3) 

 

Para insertar una grilla en coordenadas UTM, se usa el asistente de cuadriculas y retículas 

(ver Figura 68), realizando los siguientes pasos: 

 
- Dirigirse al menú View. 

- Dar clic en Data Frame Properties. 

- Ir a la pestaña Grids. 

- Hacer clic en New Grid para abrir el asistente (avanzar con clic en Next para finalizar 

la configuración de cada ventana). 

- En la ventana Grids and Graticules Wizard seleccionar Measured Grid para mostrar 

las cuadriculas de coordenadas proyectadas en el mapa. Graticule, para retículas 

divididas por meridianos de longitud y paralelos de latitud. Reference Grid, genera 

una cuadricula de referencia dividida por filas y columnas. 

- Si se selecciona Measured Grid aparece la ventana Create a measured grid. En la 

sección Apparence se selecciona la forma y estilo de la grilla. Por defecto la sección 

Coordinate System muestra el sistema de coordenadas usado en el actual mapa, 

pero es posible cambiarlo. En la sección Intervals se define el espaciamiento de los 

ejes XY, para este caso 100 metros. 

- Si se selecciona Appearance en la opción Grid and Labels, aparecerá la ventana Axes 

and Labels donde se puede configurar los ejes (Axes) de la grilla y el estilo de línea. 

Para personalizar el estilo de texto se debe hacer clic frente a Text style. Cuando se 

hayan configurado todos los parámetros se da clic en Next. 
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- Finalmente aparece la ventana Create a measured grid donde se puede configurar 

el lugar de los bordes en la grilla. La sección Grid Properties permite almacenar la 

grilla como un gráfico estático o actualizable ante los cambios de ubicación y escala 

del mapa. 

 

Figura 68. Pasos del asistente de cuadrículas y retículas en el orden: Grids and Graticules Wizard, Create a 

measured grid, Axes and labels, y Create a measured grid. 

 

Generalmente cuando se añade una cuadrícula de coordenadas proyectadas, las etiquetas 

de los ejes muestran seis decimales (por ejemplo: 691900000000 9532700000000). En las 

propiedades de cada grilla se pueden administrar las cuadrículas y retículas existentes. Para 

eliminar los decimales sobrantes de los ejes de la grilla se debe seguir los siguientes pasos: 

 
- Ir al menú View. 

- Clic en Data Frame Properties. 

- Dirigirse a la pestaña Grids. 

- Selecciona la grilla y clic en Properties. 

- Dirigirse a la pestaña Labels. 

- Clic en Additional Properties. 

- Clic en Number Format. 

- En la sección Rounding dejar en cero el número de decimales. 
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Norte geográfico (4) 
 

Para indicar la orientación del mapa se usa la flecha de norte. Desde el menú Insert se debe 

seleccionar Insert North Arrow. Luego se ubique sobre el símbolo de la flecha norte 

requerido (ESRI North 2) y dar clic en OK para agregar. Con el botón Selects Elements  ) 

en la barra de herramientas Draw se puede seleccionar la flecha de norte y cambiar el 

tamaño y desplazarla libremente sobre el mapa. 

 
Mapa de ubicación (5) 

 

Conocer el lugar en el que se encuentra situada el área de estudio permite al lector de mapas 

ubicarse espacialmente dentro de un contexto más amplio. En ArcMap se pueden agregar 

indicadores de localización para conectar marcos de datos (Data Frame). El mapa de 

ubicación se puede agregar considerando los siguientes pasos: 

 
- Ir al menú Insert > Data Frame para agregar un nuevo marco de datos en blanco. 

- Con el botón Select Elements (  ; de la barra de herramientas Draw) ajustar el 

tamaño y posición del nuevo marco de datos. 

- Con el botón Add Data   ;de la barra de herramientas Standard) añadir una o 

varias capas que indiquen la extensión espacial superior al área de estudio. Por 

ejemplo, si el área de estudio es Ecuador sería conveniente agregar la capa de 

Sudamérica. 

- Configura la simbología y diseño de las capas del nuevo marco de datos. 

- En la tabla de contenidos hacer clic derecho sobre el nuevo marco de datos (New 

Data Frame) y seleccionar Properties. 

- Dirigirse a la pestaña Extent Indicators (Figura 69). 

- Desde la caja Other data frames agregar el Data Frame (Layers) a la caja Show extent 

indicator for these data frames. 

- Opcionalmente se puede configurar el estilo del Data Frame en la sección Options 

(nombre del Data Frame). 

- Insertar un cuadro de texto desde el menú Insert > Text, para añadir el título (por 

ejemplo: Mapa de ubicación). 
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Figura 69. Configuración de indicadores de localización 
 

Se pueden insertar tantos marcos de datos como se requieran. Tomar precaución cuando el 

área de estudio es demasiado pequeña en comparación al área que muestra su localización. 

 
Para intercambiar entre cada marco de datos ( ) en la tabla de contenidos hacer clic 

derecho sobre Layers y seleccionar Activate. Solo se pueden manipular las capas de un marco 

de datos cuando el mismo se encuentra activo. 

 
Leyenda (6) 

 

Una leyenda permite al lector de mapas conocer el significado de los símbolos utilizados para 

representar cada elemento incorporado dentro del mapa. Para abrir el asistente de leyenda 

se debe realizar los siguientes pasos: 

 
- Ir al menú Insert y selecciona Legend (para avanzar entre ventanas, hacer clic en 

Next). 

- En esta ventana, en la sección Choose which layers you want to include in your 

legend, desde Map Layers se deben pasar las capas que se desean mostrar a Legend 

Items usando las flechas existentes. Cuando existen varios elementos en la leyenda 

se puede optar por organizar en columnas. Establecer el número de columnas en Set 

the number of columns in your legend. 

- En la siguiente ventana, en Legend Title se debe asignar un título a la leyenda. En la 

parte inferior se puede personalizar el texto. 
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- La próxima ventana, en Legend Frame permite personalizar el borde, fondo y 

sombreado de la leyenda. Se recomienda realizar cuidadosamente la combinación 

de estilos para obtener un diseño atractivo. 

- La siguiente ventana permite cambiar el tamaño y forma de los símbolos usados para 

representar líneas y polígonos. Generalmente se suele dejar la configuración por 

defecto. 

- En la última ventana se puede configurar el espaciamiento entre cada uno de las 

partes de la leyenda. Si todo se ha configurado satisfactoriamente, hacer clic en 

Finish. 

- Usar el botón Select Elements (  ; de la barra de herramientas Draw) para 

ajustar el tamaño y posición de la leyenda. 

 

Figura 70. Ventana de inicio del asistente de leyendas 
 

Escala numérica (7) 
 

La escala numérica muestra la relación entre los valores de longitud que se muestran en el 

mapa y los valores de longitud reales del terreno. Antes de insertar la escala numérica en el 

mapa, especificar el valor de la escala (3000) en el Map Scale de la barra de herramientas 

Standard (Figura 5). 
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Para ello, hay que dirigirse al menú Insert y hacer clic en Scale Text. De la lista de diversos 

formatos de escalas numéricas seleccionar Absolute Scale y hacer clic en OK. Se puede 

comprobar que el denominador de la escala numérica así generada es dinámico: al modificar 

la escala del mapa automáticamente cambia el denominador de la escala. 

 

Con el botón Select Elements  ) se puede ajustar su posición dentro del mapa. 

Adicionalmente debe ir al menú Insert > Text para añadir un cuadro de texto. Escribir la 

palabra “Escala:”. Con el botón Select Elements ajustar el cuadro de texto delante de la 

escala numérica. De forma que se pueda leer: “Escala 1:3.000”. 
 

Escala gráfica (8) 
 

La escala gráfica es una barra dividida en partes que indica visualmente la longitud sobre el 

terreno. Para agregar una escala gráfica se debe ir al menú Insert y seleccionar Scale Bar. De 

la lista barras de escala se puede seleccionar la escala preferida (por ejemplo: Alternating 

Scale Bar 1). Con el botón Select Elements (  ) ajustar la posición. 

Para configurar la escala gráfica se debe tomar en cuenta los siguientes aspectos: 
 

- Con el botón Select Elements (   ) dar clic derecho sobre la escala gráfica y 

selecciona Properties. 

- Ir a la pestaña Scale and Units. 

- En la sección Units seleccionar metros como unidad de división. En Label escribir: 

Metros. 

- En la sección Scale en When resizing selecciona Adjust width. Inserta el valor 2 en 

Number of divisions y Number of subdivisions; en Division value inserta 50 (la 

longitud de la escala gráfica se obtiene multiplicando los valores de Division value y 

Number of divisions). 
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Figura 71. Configuración de la escala gráfica 
 

Parámetros de referencia geodésicos (9) 
 

Siempre es necesario especificar el sistema de referencia geodésico usado en la elaboración 

del mapa. Para ello se puede ir al menú Insert > Text y escribir el siguiente texto: 

 
Proyección Universal Transversa de Mercator. 

Elipsoide y Datum Horizontal WGS 84 Zona 17 Sur. 

 
Área de tarjetas o cajetines (10) 

 

Las tarjetas o cajetines permiten adicionar información en el mapa. Se puede incluir el 

nombre de los responsables de la elaboración, nombre del proyecto o programa, logotipos, 

fuente de los insumos cartográficos, fecha de elaboración, escala de trabajo, etc. 

 
Para agregar un logotipo se debe ir al menú Insert > Picture. Explorar y seleccionar la imagen 

a usar. Ajustar el tamaño y posición con el botón Select Elements (  ). 

Además, se puede construir un cajetín de información con las herramientas de dibujo de 

ArcMap. Pero se recomienda insertar como objeto. Para ello se debe ir al menú Insert > 
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Object > Microsoft Word Document. En el documento de Word que se abre, como ejemplo 

se puede copiar la Tabla 6, luego cerrar Word. Finalmente, se ajusta el tamaño y posición con 

el botón Select Elements (  ). 

Tabla 6. Tarjeta de información 
 

Cajetín informativo 

Mapa base comunal 

Tema: Mi primer mapa en ArcGIS 

Fuente: Ortofoto Programa SIG Tierras Fecha: Julio 2017 

 

Cuando se ha ingresado todos los elementos a publicar en el mapa se recomienda organizar 

cada uno de los elementos para obtener una mejor presentación visual del mapa. Por 

ejemplo, al seleccionar varios elementos y hacer clic derecho sobre los mismos se muestran 

las opciones para agrupar, alinear, distribuir, etc. 

 

11.3. Exportar e imprimir un mapa 

 
Una vez finalizado el proceso de elaboración de un mapa, este se puede enviar a imprimir o 

exportar en diversos formatos. 

 

Para imprimir el mapa ir al menú File > Print, y configurar la impresora de acuerdo a las 

características con las que cuente. 

 

Si se requiere tener el mapa en otro formato digital se lo exporta desde el menú File > Export 

Map. Se seleccionar entre los formatos EMF, EPS, AI, PDF, SVG, BMP, JPEG, PNG, TIFF, y GIF. 

En cada formato se puede configurar la resolución y parámetros adicionales. 

 

En algunos casos, especialmente cuando se cuenta con caracteres especiales, al general un 

archivo PDF no todos los elementos suelen estar legibles. Para ello se recomienda usar una 

impresora PDF que se encuentre instalada en el sistema. 

 

Finalmente se puede ver el resultado del mapa elaborado siguiendo las instrucciones del 

presente documento (Figura 72). 
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Figura 72. Ejemplo de un mapa elaborado con ArcGIS 10 
 

12. Preguntas frecuentes 

 
¿Qué zona selecciono si mi área de estudio comparte dos zonas UTM? 

 

Lo que se suele hacer en estos casos es trabajar con la zona que posea la mayor parte del 

área de estudio. Seguro que un geodesta dará una solución mejor, aunque también es más 

complicada. 

 
¿Si copio un proyecto MXD, se copian todas las capas del mapa (shapefiles e imágenes)? 

 

No, un archivo MXD simplemente gestiona las rutas a los archivos y la configuración de la 

visualización de leyendas, escalas de visualización, selección de casos, etc., entre otras cosas, 

pero no las capas mismas. Antes de iniciar un proyecto se recomienda almacenar todas las 

capas dentro de un solo directorio. En el menú File > Map Document Properties activar la 

casilla Store relative pathnames to data sources para facilitar conexión de los archivos 

vinculados al MXD. 

 
También se puede empaquetar un proyecto de mapa y todas las capas asociadas a este. Para 

hacer esto, ir al menú File > Share As para crear un Map Package. Se deja al estudiante que 

investigue el uso (e inconvenientes) de esta herramienta. 
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¿Cómo puedo colocar etiquetas a una capa? 
 

Las etiquetas permiten mostrar textualmente la información de los elementos que 

conforman una capa. Por ejemplo, si se requiere mostrar los valores de una capa de curvas 

de nivel, los nombres de hospitales en una capa de puntos, el nombre de los parques 

nacionales en una capa de polígonos. 

 
Para añadir etiquetas hacer clic derecho sobre una capa y seleccionar Properties. Ir a la 

pestaña Labels y activar la casilla Label features in this layer. En la sección Text String en 

Label Field seleccionar el campo que contiene la información a mostrar en el mapa. 

 
Si bien en la pestaña Label se puede configurar el estilo, posicionamiento y otras opciones 

para las etiquetas. Para mayor personalización se puede cambiar el motor de etiquetado 

desde el menú View > Data Frame Properties > Pestaña General > Label Engine > Maplex 

Label Engine. 

 
¿Cuáles son los elementos principales que debe tener un mapa? 

 

Esto depende de muchos factores, entre otros: audiencia del mapa, tamaño del papel en el 

que se va a imprimir, distancia desde la que va a ser visualizado, etc. Suponiendo que estamos 

preparando un mapa para un trabajo académico o una consultoría, desde nuestro punto de 

vista los elementos que siempre van a ser necesarios son la escala gráfica, la o las leyendas, 

la rejilla de las coordenadas y el norte. Si el mapa se presenta en una página aparte es muy 

recomendable el uso de cajetines, donde irán indicados el título del mapa, los autores, la 

institución donde fue realizado y la fecha, por ejemplo, en el caso de que el mapa forme parte 

de un documento de texto y vaya insertado en este, el título del mapa debe ir en el pie de 

figura. 

 
¿Cuál es la diferencia entre proyección y datum? 

 

En términos sencillos la proyección es el método que se usa para representar la curvatura de 

la tierra en una superficie plana, y el datum es el conjunto de parámetros que se usan para 

realizarlo. 

 
¿Es posible crear varios Layouts en ArcMap? 

 

No, solo se puede crear uno por proyecto de mapa (uno por cada MXD). 
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¿Puedo insertar una grilla de coordenadas planas y otra de coordenadas geográficas? 
 

Sí, se puede. En las propiedades del Data Frame, ir a la pestaña Grids > New Grid. Se puede 

agregar una añadir varias rejillas de coordenadas. 

 
¿Por qué mis datos no tienen un sistema de referencia? 

 

Este problema ha sido muy frecuente en el ámbito de los SIG. Lo más probable es que quién 

creó los datos no definió el sistema de referencia espacial utilizado. Tampoco se puede 

adivinar el sistema de referencia usado sino se cuenta con algún registro. En los shapefiles el 

archivo de referencia tiene extensión PRJ. 

 
¿Puedo importar archivos CAD en ArcGIS? 

 

Sí. Vamos a suponer que tenemos un archivo de AutoCAD (DWG) que almacena un mapa 

topográfico. Pinchamos en Add Data y localizamos el archivo de AutoCAD. Pinchamos dos 

veces sobre él y nos aparece una lista de archivos que en realidad son los tipos de geometrías 

contenidas en el archivo de AutoCAD. Ahora supongamos que queremos exportar las curvas 

de nivel del archivo de AutoCAD. Las curvas de nivel son siempre polilíneas, entonces 

elegimos Polyline y pinchamos en Add. Con esto hemos cargado en ArcMap todas las 

polilíneas del archivo de AutoCAD. Como solo queremos exportar las curvas de nivel (vamos 

a suponer que estas se encuentran en la capa 27) tenemos que indicarle a ArcMap que solo 

queremos visualizar esta capa. Para eso vamos a Layer Properties y pinchamos en la pestaña 

Drawing Layers, desactivamos todas las capas y activamos solo la capa de las curvas de nivel. 

Una vez que solo visualizamos las curvas de nivel, podemos exportar la capa a cualquier 

formato vectorial (Data > Export Data). 

 
¿Puedo agregar nuevos símbolos en ArcGIS? 

 

Sí. En el administrador de estilos se puede insertar nuevos símbolos. Ir al menú Customize > 

Style Manager. Dirigirse al archivo de estilos del usuario local de Windows. Ubicarse en una 

categoría y con clic derecho seleccionar New. 

 
¿Es posible convertir un mapa de pendientes de grados a porcentaje? 

 

Sí. Se puede hacer con la calculadora ráster. La fórmula es: 
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s[%]=tan(s[°])*100 
 

donde s[%] es la pendiente en porcentaje y s[°] es la pendiente en grados. 
 

¿Puedo importar la tabla de un shapefile en Microsoft Excel? 
 

Sí, al menos en las versiones antiguas de Excel sí. Y en Excel 2016 también. Hay que abrir el 

programa e indicarle que queremos abrir un fichero. En el tipo de archivo hay que indicarle 

dBase (*.dbf). Con Libre Office también se lo puede hacer. Pero mucho cuidado, que se pueda 

hacer no significa que sea aconsejable. De hecho, no lo es, ya que si haces algo raro como 

borrar alguna columna o incluso borrar alguna fila es posible que el shapefile quede corrupto 

e inutilizable. Lo aconsejable es que copies solo el archivo DBF a otro directorio y ahí lo abras 

y lo modifiques como quieras. Cualquier modificación de la base de datos asociada a un 

shapefile es recomendable que se haga en un SIG. 

 
¿Puedo convertir un shapefile de puntos a polígonos? 

 

Si se puede. Pero es posible que el resultado no sea lo que esperas. Por decirlo de una forma 

simple: a partir de, digamos 100 puntos, y sin violar las reglas topológicas, se pueden formar 

un sin número de polígonos diferentes. Por otro lado, hay una herramienta que genera un 

solo polígono a partir de una capa de puntos. Se llama Minimum Bounding Geometry y se 

puede encontrar en ArcToolbox, en Data Managemet Tools > Features. Su uso es muy 

intuitivo. 

 
¿Por qué ArcGIS suele cerrarse inesperadamente? 

 

En ocasiones las aplicaciones de ArcGIS suelen cerrarse inesperadamente sin motivo alguno. 

Al aceptar enviar el informe de errores se envía directamente al equipo de desarrolladores 

de Esri. Algunos errores se suelen corregir instalando los Service Pack correspondientes a 

cada versión. 

 
¿Por qué cuándo exporto un mapa a PDF no todos símbolos se pueden visualizar? 

 

Por lo general, cuando se usan caracteres especiales al exportar un mapa en formato PDF no 

todos los caracteres suelen mostrarse. Se recomienda exportar a formato PDF desde Print 

usando una impresora PDF. 
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¿Cómo puedo ver la tabla de contenidos si la he cerrado? 
 

A veces por accidente cerramos la tabla de contenidos. Nos volvemos locos durante un rato 

porque pensamos que es una barra de herramientas y tratamos de activarla donde se activan 

estas. Para volver a activar la tabla de contenidos se debe ir al menú Windows > Table of 

Contents. 

 
¿Es posible calcular el centroide de un polígono? 

 

Claro que sí. Es muy fácil, se hace con la herramienta Feature To Point en ArcToolbox > Data 

Management Tools > Features. El funcionamiento de esta herramienta es muy sencillo. Solo 

una cosa a tener en cuenta: si activamos la casilla de verificación "Inside (optional)" nos 

aseguraremos de que todos los puntos caen dentro de sus respectivos polígonos, pero a 

cambio estos puntos ya no serán los centroides de los polígonos en el sentido estricto de la 

palabra centroide. 

 
¿Por qué existe un desplazamiento en las capas de mi proyecto? 

 

Es muy posible que las capas tengan diferente sistema de referencia espacial. También es 

probable que la escala de trabajo e insumos fueron diferentes al momento de generar las 

capas. 

 
¿Cómo puedo conocer la resolución de un ráster? 

 

Pinchas dos veces sobre la capa, vas a la pestaña Source y en la tabla Property buscas la fila 

Cell Size (X,Y) (en mi versión es la tercera). Ojo! No te confundas: en este campo hay dos 

datos, la resolución en X y la resolución en Y. Por lo que si ves 3, 3 no quiere decir que la 

resolución espacial de la capa es de tres coma tres metros, sino que la resolución en X es de 

tres metros y la resolución en Y es de tres metros. Teóricamente los SIG pueden manejar 

capas ráster de diferente resolución en X y en Y, aunque ver este tipo de capas es 

extraordinariamente raro. Hasta donde conocen los autores de este documento solo algunos 

SIG como GRASS se manejan bien en estas situaciones. 

 
¿El tamaño de píxel es igual al tamaño de celda? 

 

Sí, el tamaño de píxel es el tamaño de celda o la resolución espacial de un ráster. De acuerdo 

a (ESRI, 2016d) una celda debe ser suficientemente pequeña para capturar el detalle 
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necesario y lo suficientemente grande para ejecutar tareas de análisis y almacenar 

eficientemente la información. A menor tamaño de píxel aumenta la resolución del ráster y 

el tamaño del fichero. 

 
¿Cómo puedo copiar un shapefile a otro ordenador? 

 

Lo más fácil es que utilices ArcCatalog. Este programa tiene funcionalidades parecidas al 

Explorador de Windows, pero con capas de SIG, por lo que con él es muy fácil copiar, cortar 

y pegar capas de SIG, entre ellas los shapefiles. Si quieres hacerlo con el Explorador de 

Windows y por ejemplo quieres copiar la capa "red_vial.shp", tienes que asegurarte de copiar 

todos los ficheros que estén en ese directorio y cuyos nombres comiencen por "red_vial." ya 

que, como sabes, una capa shapefile está compuesta por varios ficheros, como mínimo tres 

y en la mayor parte de los casos seis. 

 
¿Puedo abrir un MXD en una versión anterior de ArcMap? 

 

En un principio no. Lo que sí puedes hacer es guardar el MXD como archivo de proyecto de 

una versión anterior de ArcMap. Esto se puede hacer desde File > Save A Copy y en Tipo 

eliges la versión de ArcMap para la que quieres que funcione el archivo de proyecto. 

Recuerda que las versiones superiores abren los archivos de proyecto de las inferiores, pero 

no al revés. 

 
¿Tengo problemas al ejecutar una herramienta de ArcToolbox? 

 

Si al abrir una herramienta de ArcToolbox sale un mensaje similar a este “Unable to execute 

the selected tool. You do not have the necessary license to execute the selected tool”. Se debe 

asegurar tener una licencia de la extensión a usar. Para activar una extensión ir al menú 

Customize > Extensions. Las extensiones solamente se activan si se cuenta con una licencia. 

 
En algunos casos al intentar abrir una herramienta de ArcToolbox arroja el mensaje “Do you 

want to open or save this file?” con referencia al archivo MdDlgContent.htm. Para intentar 

solucionar este error se debe seleccionar los Programas de Microsoft Windows como 

predeterminados en la configuración de Windows. 
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¿Por qué no puedo seleccionar A1 en el tamaño de impresión? 
 

El tamaño de papel en ArcMap por defecto está disponible según las opciones de la 

impresora instalada. Si una impresora solo admite A4, no es posible seleccionar un tamaño 

superior. Para seleccionar cualquier tamaño de papel en la ventana de impresión (File > Print) 

desactivar la casilla Use Print Paper Settings. 
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